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1  Printer Overview
This printer lets you print, copy, scan, and fax pictures and documents. In addition, 
this printer supports networking, letting you access the printer over a wireless 
(Wi-Fi) or Ethernet network. 

Components

1 Control panel 10 Scanner glass

2 ADF paper-edge guides 11 Access door

3 Left paper-edge guide 12 Printhead with ink cartridges installed

4 Paper input tray 13 Line in phone port

5 Automatic Document Feeder (ADF) 14 Ext out phone port

6 Right paper-edge guide 15 USB port (for connecting to computer) 

7 Front USB port (ESP Office 2170 Printer only) 16 Power cord connection port

8 Memory card slot 17 Output tray extender

9 Scanner lid 18 Output tray
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Printer Overview
Control panel 

Feature Description
1 LCD Displays pictures, messages, and menus
2 Copy mode button Displays the Copy Options menu
3 Fax mode button Lets you enter a phone number for sending a fax, or choose the Fax Options menu
4 Navigation buttons Used to navigate menus and scroll through pictures
5 OK button Selects a menu item, accepts a setting, and continues with the current operation
6 Attention light Blinks when an error occurs
7 Phonebook button Displays the phonebook of fax numbers entered on this printer; lets you enter or edit 

phone numbers
8 Numeric keypad Used to dial a phone number or a Quick Dial number for faxing; to enter information 

and Quick Dial settings into the fax phonebook; to specify a quantity for making 
copies; and to enter information for authenticating access to a network

9 Cancel button Stops the current operation and returns to the menu; clears certain errors to allow 
scanning or sending a fax

10 Start Black button Starts the selected operation in black and white
11 Power button Turns the printer on or off
12 Wi-Fi connectivity LED When lit, signals that the printer is connected to a wireless (Wi-Fi) network; blinks 

when searching for an available Wi-Fi network or when the existing signal is too 
weak to transmit or receive wireless signals

13 Start Color button Starts the selected operation in color, if the source is in color
14 Redial button Displays the last eight phone numbers dialed
15 Auto Answer button Turns the fax auto answer feature on or off; when on, the fax answers all incoming 

calls automatically
16 Auto answer LED Lights when the fax auto answer feature is on
17 Home button Displays the main menu
18 Back button Displays the next higher screen in the menu structure
19 Photo mode button Displays the Print Photo Options menu 
20 Scan mode button Displays the Scan Options menu

1 2 3 4 5 6 7 118 9 10

12131415161718181920
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KODAK ESP Office 2100 Series All-in-One Printer
Home Center Software 
KODAK Home Center Software is installed with your KODAK All-in-One Printer 
Software, unless you choose otherwise. The Home Center icon will appear on your 
desktop. 

NOTE: You can choose to install the KODAK AiO Printer Software Essentials, which 
include the drivers and Printer Tools only. 

On a computer with WINDOWS Operating System (OS), you can use Home Center 
Software to:

• browse, crop, enhance, and edit pictures

• print and scan

• make 3D pictures (from picture pairs taken to create 3D pictures)

• print from video

• send images to or print images from KODAK Gallery

• send images to or print images from FACEBOOK Social Network, FLICKR, 
PHOTOBUCKET, PICASA, SMILEBOX Photo Management Systems, and 
Google Docs

• configure your printer

• install new network printers

• upgrade to the latest printer software and firmware

• order supplies

• access the KODAK Tips and Projects Center

• access the Online Printer Management Tool 

On a computer with MAC OS, you can use Home Center Software to: 

• scan

• configure your printer

• upgrade to the latest printer software and firmware

• order supplies

• see the status of your printer

• access the KODAK Tips and Projects Center

• access the Online Printer Management Tool 
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Printer Overview
Ordering supplies
You can order ink cartridges, paper, and accessories online. An Internet connection 
is required. 

To order supplies directly from Home Center Software:

1. Open Home Center Software.

2. Select Order Supplies (on a computer with WINDOWS OS) or select the Tools 
tab, then click Order Supplies (on a computer with MAC OS). 

3. Select the item(s) you want to buy, then follow the on-screen instructions. 

To order supplies directly from the Web:

• For ink, go to www.kodak.com/go/printingsupplies

• For paper, go to www.kodak.com/go/inkjetpaper
4 www.kodak.com/go/aiosupport
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KODAK ESP Office 2100 Series All-in-One Printer
Configuring printer settings
NOTE: When you first power on the printer, the LCD prompts you to select the 

Language and Country/Region. 

To set or change basic printer settings: 

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select one of the following settings: 

• Date and Time
– Press OK, then press  to select Year, Month, Day, Hour, or Minute.

– Press or  to change the values; press OK when you are done. 

– Press Back to return to the Printer Settings menu.

• Time to Low Power
To conserve energy, your printer will enter a low power (sleep) mode after 
being idle for a default delay time of 1 hour. You can increase the delay time to 
low power (in 0.5 hour increments) up to 4 hours. Increasing the delay time 
may result in reduced energy savings.

– Press  to change the time to energy-saving sleep mode (select from 1 to 
4 hours in 0.5 hour increments). 

• Tagged Images Printing (see Printing tagged pictures, page 51)

– Press  to select Off or On.

• Language
– Press OK, press  to select a language, then press OK.

• Country/Region
– Press OK, press  to select a country or region, then press OK.

• Reset All Settings (see Resetting factory defaults, page 107)

NOTE: Resetting factory defaults does not change the date and time, 
language, country/region, or network settings.

• Printer Info
– Press OK to view the Firmware Version number; press OK when you are 

done.

4. Press Back to return to the Main Menu. 
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2 Networking Your Printer
This section explains how to configure or change your wireless network settings.

Connecting to a wireless network
To connect your printer to an 802.11b/g/n wireless (Wi-Fi) network, refer to the 
following information. 

Before you connect

You need:

• a wireless router.

• to determine whether your wireless router supports Wi-Fi Protected Setup 
(WPS).

NOTE: If you have specific questions about your router, see your router 
manufacturer’s documentation for more information.

Connecting to a wireless network using the Wi-Fi Setup Wizard

You can use the Wi-Fi Setup Wizard on the printer to connect to your wireless 
network. Use the procedures that is appropriate for your network setup.

Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network 
name, also called the Service Set Identifier (SSID). You can obtain your network 
name from the wireless router. See the manufacturer's documentation for more 
information. 

If you have enabled security on your network, you also need to know the security 
string (passphrase or password), which may be a Wired Equivalent Privacy (WEP) 
or a Wi-Fi Protected Access (WPA/WPA2) passphrase. 

Record your network information using the correct uppercase and lowercase letters.

Network Name (SSID): _______________________________________

Security String (case-sensitive): ________________________________

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. With Wi-Fi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on when you select Wi-Fi Setup Wizard.
6 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
The Wi-Fi connectivity LED blinks as the printer searches for available wireless 
networks within range, then displays the list in order of signal strength. For 
example:

If there are additional networks than can be shown on the LCD, press  to view 
them. 

4. Press  to select your network, then press OK. 

If you don’t see your network in the list, or if you want to change your network, 
select Rescan for Wireless Networks, then press OK.

NOTE: If the name of your network is not listed, make sure your wireless router 
is turned on and within range. 

5. If your network requires a password, use the LCD keyboard to enter your 
Security String. The Security String is case-sensitive.

6. When the confirmation message appears, press OK.

On the control panel, press , , or  
to select the letters and numbers. When you 
are finished, select DONE, then press OK
www.kodak.com/go/aiosupport 7



Networking Your Printer
When the printer is successfully connected, the Wi-Fi connectivity LED will stop 
blinking and remains lit.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034). 

7. If you haven’t yet installed the KODAK All-in-One Printer Software, insert the 
CD that came with the printer into the computer CD drive, and follow the 
on-screen instructions. When the software checks for updates, if a newer 
version exists, install the newer version. (On a computer with MAC OS, be sure 
to select the option to check for newer versions.) 

NOTE: If you do not have the CD:

a. Go to www.kodak.com/go/aiodownloads. 

b. In the results list, click the link for KODAK All-in-One Printer Software 
for your computer’s operating system.

c. Follow the on-screen instructions. 

Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), use WPS Connect. WPS lets 
you configure your printer for a wireless network by pressing buttons or entering a 
PIN.

To connect to a network using WPS:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. With Wi-Fi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup 
Wizard.

4. With WPS Connect selected, press OK.
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KODAK ESP Office 2100 Series All-in-One Printer
5. Select one of two methods of connecting: 

IMPORTANT: Before you press OK on the printer, make sure you know where the 
router's push button is, or where to enter the generated PIN. If 
necessary, consult your Internet Service Provider or router device 
manufacturer’s documentation for more information.

6. When the confirmation message appears, press OK.

When the printer is successfully connected, the Wi-Fi connectivity LED stops 
blinking and remains lit.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034).

7. If you haven’t yet installed the KODAK All-in-One Printer Software, insert the 
CD that came with the printer into the computer CD drive, and follow the 
on-screen instructions. When the software checks for updates, if a newer 
version exists, install the newer version. (On a computer with MAC OS, be sure 
to select the option to check for newer versions.) 

NOTE: If you do not have the CD:

a. Go to www.kodak.com/go/aiodownloads. 

b. In the results list, click the link for KODAK All-in-One Printer Software 
for your computer’s operating system.

c. Follow the on-screen instructions. 

Using Push Button Configuration Entering WPS PIN

NOTE: You will have two minutes to 
press or select the WPS button. 
It may be a button on the device 
or a virtual button in the device’s 
software.

a. With Push Button Configuration 
selected, press OK. 

b. Press or select the WPS button for 
your wireless router.

a. Press  to select Generate 
WPS PIN, then press OK.

b. In your wireless router’s software, 
locate the PIN screen, then follow 
the router’s instructions.

c. Enter the PIN you received on the 
LCD into the PIN screen. 
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Networking Your Printer
Setting up an IP Address
IMPORTANT: You should only need to set up an IP Address for your printer if you are 

having a problem connecting your printer to a wireless network. Typically, it 
is not necessary to set up an IP Address. This procedure is for advanced 
users. 

All IP Address entries have the following format: 000.000.000.000. If an address or 
Subnet Mask has only one or two characters between the periods, include one or 
two leading zeros in front of that number. For example: 

To set up your IP Address on the printer:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. Press  to select Advanced IP Address Setup, then press OK.

4. Press OK again to continue.

5. Select one of the following, then press OK:

• Dynamic (DHCP)
• Manual (Static)

6. If you selected Manual (Static), you are prompted to enter an IP Address, a 
Subnet Mask, a Gateway Address, and a DNS Server address. Press OK after 
each entry. Use the navigation buttons to enter each digit of the numbers.

Consult your Internet Service Provider or network administrator for more 
information.

The address as it may appear 
in your documentation

How to enter the address 
in the printer menu

149.89.138.149 149.089.138.149

149.2.40.149 149.002.040.149
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KODAK ESP Office 2100 Series All-in-One Printer
Viewing the network configuration
To view the network configuration and verify that you are connected to your wireless 
network:

1. Press Home.

2. Press  to select Network Settings, then press OK.

3. Press  to select View Network Configuration, then press OK.

The wireless network settings appear on the LCD, including:

• Printer Name

• Printer Hostname

• Connection

• Speed 

• IP Address

• IP Address Type

• Network Subnet

• Connected Network SSID

• Security

• Authentication

• Channel

• Region

• Radio (on/off)

• MAC Address

If the printer is connected to your network, you will see the network name and 
the word CONNECTED. 

4. To scroll through the information, press . 

5. When you are done, press OK.

Printing the network configuration
To print the current network configuration:

1. Load plain paper into the printer. (See Loading plain paper, page 38.)

2. Press Home.

3. Press  to select Network Settings, then press OK.

4. Press  to select Print Network Configuration, then press OK.
www.kodak.com/go/aiosupport 11



Networking Your Printer
Installing your printer on additional computers on the network
To add your printer to another computer(s) on your network, install the KODAK 
All-in-One Printer Software on each computer. 

• Insert the CD that came with the printer into the computer CD drive, and follow 
the on-screen instructions. When the software checks for updates, if a newer 
version exists, install the newer version. (On a computer with MAC OS, be sure 
to select the option to check for newer versions.) 

NOTE: If you do not have the CD:

a. Go to www.kodak.com/go/aiodownloads. 

b. In the results list, click the link for KODAK All-in-One Printer Software 
for your computer’s operating system.

c. Follow the on-screen instructions. 

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have an ESP 7 
printer and now you are adding an ESP Office 2150 printer), you must install the 
KODAK All-in-One Printer Software for the newer model. 

NOTE: When you install the new software, the printer driver for the ESP 7 printer 
will be uninstalled, and an upgraded driver for the ESP 7 printer will be 
installed in addition to the driver for the ESP Office 2150 printer. 

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > KODAK Printer Setup Utility.

• If your wireless printer (example: KodakESPOffice2150+0034) is not listed: 

a. Select No, my printer is not listed, then click Next.

b. From the drop-down list, select your printer.

c. Select Network - Wireless/Wi-Fi, then click Next.
When your printer is detected, driver installation begins.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) is 
listed:

a. Select the all-in-one printer that is connected to your network.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

2. When driver installation is complete, click Done. 

On a computer with MAC OS:

1. Select Apple > System Preferences.

2. Under Hardware, select Print & Fax or Print & Scan.

3. Click + in the dialog box. 

4. Select your printer from the list.

5. Click Add, if required. 
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KODAK ESP Office 2100 Series All-in-One Printer
Adding a wireless network connection to a USB-connected computer
You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1. Disconnect the USB cable from your printer and computer.

2. On your computer, disable any firewall you have installed until you have 
successfully completed the installation. 

3. If you have not already done so, connect your printer to your wireless network. 
See Connecting to a wireless network, page 6.

4. Select Start > All Programs > Kodak > KODAK Printer Setup Utility.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) 
is not listed:

a. Select No, my printer is not listed, then click Next.

b. Select your printer from the list.

c. Select Network - Wireless/Wi-Fi, then click Next. 
When your printer is detected, driver installation begins.

• If your wireless all-in-one printer (example: KodakESPOffice2150+0034) 
is listed: 

a. Select the all-in-one printer that is connected to your network.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

5. When driver installation is complete, click Done. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034).

If your printer is connected to a computer with MAC OS:

1. Disconnect the USB cable from your printer and computer.

2. If you have not already done so, connect your printer to your wireless network. 
See Connecting to a wireless network, page 6.

3. Select Apple > System Preferences.

4. Under Hardware, select Print & Fax or Print & Scan.

5. Click + in the dialog box. 

6. Select your printer from the list.

7. Click Add, if required. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESPOffice2150+0034). 
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3 Online Printer Management Tool
The KODAK Online Printer Management Tool lets you access your printer through 
an Internet browser (such as INTERNET EXPLORER, FIREFOX, SAFARI, CHROME) 
on any computer that is on the same network as your printer. 

IMPORTANT: Your computer and your printer must be on the same wireless or 
Ethernet network. The Online Printer Management Tool is not available if 
your printer is connected to a computer with only a USB cable. 

With the Online Printer Management Tool, you can:

• view printer status

• configure (or change) printer settings

• change fax settings and add entries to the Fax phone book

• create Scan to Email and Scan to Network Folder profiles (that you can access 
from the printer control panel)

• add entries to the Email Address book

• set up accounts for Google Cloud Print and KODAK Email Print Service
14 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Accessing the Online Printer Management Tool
Access the Online Printer Management Tool in one of the ways described below. 

Directly from Home Center Software v7.x or higher:

1. Open Home Center Software.

2. Select Printer Tools on a computer with WINDOWS OS, or Tools on a computer 
with MAC OS.

3. Make sure that the name of your wirelessly connected printer appears in the 
bottom left of the window.

NOTE: A wirelessly connected printer is listed as the name of the printer plus 
a number (for example, KodakESPOffice2150+0034). If a different 
printer name appears, click Select, then choose your wirelessly 
connected printer.

4. Under Online Printer Tools, select Online Printer Management.

The Online Printer Management Tool opens.

On any printer-supported computer: 

1. Get the IP Address of your wirelessly connected printer:

a. On your printer control panel, press Home.

b. Press  to select Network Settings, then press OK.

c. Press  to select View Network Configuration, then press OK. 

NOTE: If you prefer a printout, press  to select Print Network Configuration, 
then press OK. A Test Page prints, including the IP Address in the format 
xxx.xxx.xxx.xxx. 

d. Press  to see the IP Address in the format xxx.xxx.xxx.xxx. (See Viewing the 
network configuration, page 11.)

2. On your computer, open your preferred Internet browser (such as INTERNET 
EXPLORER, FIREFOX, SAFARI, CHROME).

3. Type the printer IP Address in the browser address (URL) bar, then press Enter.

The Online Printer Management Tool opens in the browser window.
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Online Printer Management Tool
Using the Online Printer Management Tool

Configuring printer settings

To change the standby time, volume of the button sound, or date and time:

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab.

3. Select Device. 

4. Select General or Date & Time, and make any necessary changes.

5. Click Save.

NOTE: Select Reset to restore default settings, if necessary. 
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Changing the printer name
1. Open the Online Printer Management Tool (see Accessing the Online Printer 

Management Tool, page 15).

2. Select the Network tab.

3. Select General, then Friendly Name, if necessary.

4. Highlight the text in the Friendly name field and type the name you want, then 
click Save. 
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Online Printer Management Tool
Adjusting fax settings
Edit your phone book, or change the fax settings.

Editing the fax phone book

To edit the fax phone book:

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab.

3. Select Fax > Phone Book. 

To add a phone book entry:

1. Type the name and fax number, and, optionally, select a quick dial number for 
your fax entry. 

2. Click Add.
18 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
To edit a phone book entry:

1. Select the check box for an existing entry in the Phone Book.

2. Click Edit.

3. Make the changes.

4. Click Save, then click OK.

To delete a phone book entry:

1. Select the check box for an existing entry in the Phone Book.

2. Click Delete, then click Yes.

Changing fax settings

To change fax settings:

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab.

3. Select Fax > Settings. 
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4. Enter the sender information. 

This information appears in the header of faxes you send from your printer. 
(For more information about sender information, see Entering fax sender 
information, page 82.)

5. Adjust any fax settings, as necessary. (For more information about settings, see 
Selecting fax settings, page 83.)

6. Click Save.

Setting up Scan To Email

When you scan with your printer, you can send the scans directly from the printer to 
an email recipient. To do so, you must first set up a profile for yourself, and define the 
email address(es) to which you want to send scans. 

Creating the outgoing email profile
1. Open the Online Printer Management Tool (see Accessing the Online Printer 

Management Tool, page 15).

2. Select the Settings tab. 

3. Select Scan To Email > Email Profile. 

4. Click Add New Outgoing Email Profile.
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5. In the Profile Name field, type a name that has meaning to you; for example, 
your initials and your email provider, such as LR Hotmail or LR Gmail. 

This name will appear on the printer control panel when you start a scan to be 
sent through email.

6. In the From Email Address field, type your email address.

Although the email will be sent from the printer, any replies will go to this email 
address.
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7. Under Email Server Settings, enter your email service provider. 

• If your email service provider is Gmail, Yahoo, AOL, or Hotmail, select your 
services from the drop-down menu. The Email Service and Port Number fields 
fill in automatically.

• If your email service provider is not in the drop-down menu: 

a. Type the email server name or the IP address of your email service provider 
in the Email Server field.

b. Type the port number of your email server in the Port Number field.

NOTE: Locate this information in the email account properties fields in your 
email application, or contact your Internet Service Provider. 

c. If your mail server supports secure connection mode, select the Always use 
secure connection check box.

8. If your email server requires authentication for sending emails:

a. Select the The email server requires authentication for outgoing email 
check box.

b. Type the User ID and Password for your email account.
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9. If you want to limit who uses your profile (which appears on the printer LCD) to 
send scans:

a. Select the Enable Access PIN check box.

b. Type a 4-digit numeric PIN (your choice). You will need to enter this PIN each 
time you access your profile when scanning to an email address. 

10. If you want a copies of all messages, select the Copy sender for all email 
messages sent from the printer checkbox. 

11. Click Test Profile to confirm that the printer can access your account. 

• If the printer can access your account, “Test profile: Successful” appears. 
Click OK, then click Save.

• If the printer cannot access your account, “Test Profile: Failed” appears. 
Click OK, then make changes to the profile. 

Setting up the email address book

To enter email addresses of people to whom to want to send scans by email: 

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab. 

3. Select Scan To Email > Address Book.
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4. For each person:

a. Type the person’s Name.

b. Type the person’s Email Address.

c. Click Add.

5. When you are finished adding email addresses, click OK.

Setting options for scan to email

When you send a scan to an email address, the printer uses defaults — subject line, 
body, and scan settings — that you set up under email options. 

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab. 

3. Select Scan To Email > Email Option.

4. Select and replace the default subject line and body text, if necessary. 

This subject line and body text will be included with every scan you send to 
an email address. 
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5. Select the scan settings that will be used for all scans sent to email:

NOTE: You can enter a Filename Prefix of your choice.

6. Click Save, then click OK.

You can now send a scan to an email address from the printer control panel. See 
Scanning from the printer control panel, page 70.
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Setting up Scan To Network Folder
You can scan documents or photos directly to a file in a shared folder on your 
network. 

Before you create a network folder profile

You must identify or create a network shared folder on a computer connected to the 
same network as your printer before you create a network folder profile. Note the 
network name of the folder, including the path information, and the name of the 
computer where it is located. 

To learn more about sharing folders, see the information in the links below.

• For computers with WINDOWS XP OS, see 
www.microsoft.com/windowsxp/using/networking/maintain/share.mspx

• For computers with WINDOWS VISTA OS, see 
technet.microsoft.com/en-us/library/bb727037.aspx

• For computers with WINDOWS 7 OS, see 
windows.microsoft.com/en-US/windows7/File-sharing-essentials

• For computers with MAC OS 10.5 or later, see support.apple.com/kb/ht1549
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Adding a network folder profile

To add a network folder profile that you can access from your printer control panel:

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab.

3. Select Scan To Network Folder > Network Folder Profile. 

4. Click Add New Network Folder Profile.
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5. Type: 

• Profile Name

• Folder Path

6. If the computer where the folder is located requires authentication to access its 
shared folders, type the network login User Name and Password.

7. If you want to limit who uses your profile to scan documents to your network 
folder: 

a. Select the Enable Access PIN check box.

b. Type a 4-digit numeric PIN (your choice). You will need to enter this PIN each 
time you access your profile when scanning to a network folder.

8. Click Test Profile to confirm that the printer can access the network folder.

• If the printer can access the network folder, “Test profile: Successful” appears. 
Click OK, then click Save.

• If the printer cannot access the network folder, “Test Profile: Failed” appears. 
Click OK, then make changes to the network folder profile. 

You are now ready to scan a document or photo to your network folder from the 
control panel. See Scanning from the printer control panel, page 70.
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Setting scan settings for scan to network folder

When you send a scan to network folder, the printer uses defaults that you set up 
under scan settings. 

1. Select Scan To Network Folder > Scan Settings.

2. Select the scan settings that will be used for all scans sent to a network folder:

NOTE: You can enter a Filename Prefix of your choice. 

3. Click Save, then click OK.

You can now send a scan to a network folder from the printer control panel. See 
Scanning from the printer control panel, page 70.
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Setting up Cloud Printing 

Registering your printer with Google Cloud Print

Your printer lets you print from anywhere in the world using your smartphone, 
tablet, or computer that uses Google Cloud Print enabled apps. You must register 
your printer with a Google Account to enable this feature.

1. Make sure your printer and computer are connected to the same network (see 
Networking Your Printer, page 6).

2. Make sure you have the latest version of Home Center Software and printer 
firmware (see Updating the software and printer firmware, page 105).

3. Do one of the following:

NOTE: After you select Cloud Printing Setup, the Online Printer Management Tool 
opens in your Web browser.

• Open Home Center Software, then click Cloud Printing Setup.

• Depending on your Operating System, use the path below to select Cloud 
Printing Setup.

– WINDOWS XP OS: Select Start > Programs > Kodak > KODAK AiO 
Printer Tools, then click Cloud Printing Setup.

– WINDOWS VISTA and 7 OS: Select WINDOWS icon > All Programs > 
Kodak > KODAK AiO Home Center > Printer Tools, then click Cloud 
Printing Setup.

– MAC OS: Select KODAK AiO Home Center > Tools, then click Cloud 
Printing Setup.

4. Follow the on-screen instructions.

5. Sign into your Google Account. 

6. In the Google window, click Finish printer registration.

7. Return to the Online Printer Management Tool. Wait until you see Registration 
Successful for Google Cloud Print. This may take a few minutes.

8. To register your printer with KODAK Email Print Service and get an email 
address for your printer, go to step 3 of Registering your printer with KODAK 
Email Print Service, page 31.

9. Sign out of your Google Account. 

For information about printing, see Printing using Google Cloud Print, page 54.
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Editing a Google 
Cloud Print account

Once you have successfully created an account with Google, you can make edits to 
various fields.

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab. 

3. Select Cloud Printing > Google Cloud Print. 

4. Click Edit Settings.

5. Make the changes you want in the appropriate fields, then click Save.

Registering your printer with KODAK Email Print Service 

KODAK Email Print lets you send emails and attachments to your printer using any 
email account. Your printer must be registered to Google Cloud Print before you can 
register to KODAK Email Print (see Registering your printer with Google Cloud Print, 
page 30). If you do not want to set up KODAK Email Print, you can access the set up 
at any time at www.kodakeprint.com.

1. Go to www.kodakeprint.com.

2. Sign in with the account you used to set up Google Cloud Print (see Registering 
your printer with Google Cloud Print, page 30).

3. Click Get Email Address for KODAK Printer.

4. Click Allow Access. 

You will be redirected to the KODAK Email Print Service Web site.

5. Click Enable next to your printer.

6. To limit who can send emails to your KODAK Printer email address: 

a. Next to Access Control, click Edit.

b. Select Control who can send email (by email or domain). 

c. To add a specific email address or domain, click Add new Email/Domain. 

d. Type the correct information for the email or domain, then click Save.

NOTE: To delete an email or domain, click Delete.
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Changing printer settings for copying and printing
You can change the default printer settings for copying documents and photos, and 
for printing photos. 

Changing Copy Document and Copy Photo settings

To change the default printer settings for copying documents or photos: 

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab.

3. Select Copy & Print > Copy Documents or Copy Photo.

4. Make the changes you want in the appropriate fields, then click Save.
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Online Printer Management Tool
Changing Print Photo settings

To change the default printer settings for printing photos: 

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab.

3. Select Copy & Print > Print Photo.

4. Make the changes you want in the appropriate fields, then click Save.
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4 Handling Paper
For the best document printing results, use KODAK Document Papers or a paper 
with the COLORLOK Technology logo on the package. Use only paper that is 
designed for inkjet printers.

For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with KODAK All-in-One Printers, or photo papers designed for use on 
pigment-based inkjet printers.

When handling photo paper:

• Hold the paper by the edges; avoid placing your fingerprints on it.
• Do not touch the glossy side of photo paper.
• Store paper flat, away from direct sunlight and heat.

Paper types
You can use: 

• Plain paper — 16 to 24 lb / 60 to 90 gsm
• Photo paper — 6.5 to 12 mils / 290 gsm
• Card stock — 110 lb / 200 gsm, max
• Envelopes — 20 to 24 lb / 75 to 90 gsm
• Labels — inkjet variety on 8.5 x 11-in. or A4 sheets
• Transparencies — inkjet variety with a white strip on the short edge 

• Iron-on transfers — inkjet variety on 8.5 x 11-in. or A4 sheets
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Paper sizes
The paper tray accepts the following paper sizes: 

The paper tray accepts the following standard paper sizes: 

• 4 x 6 in. / 10 x 15 cm
• 4 x 7 in. / 10 x 18 cm
• 4 x 8 in. / 10 x 20 cm
• 4 x 12 in. / 10 x 31 cm
• 5 x 7 in. / 13 x 18 cm
• 7.3 x 8.5 in. / 19 x 22 cm 
• 7 x 10 in. / 18 x 25 cm
• US Executive (7.3 x 10.5 in. / 19 x 27 cm)
• 8 x 10 in. / 20 x 25 cm

• US Letter (8.5 x 11 in. / 22 x 28 cm)
• US Legal (8.5 x 14 in. / 22 x 36 cm) 
• A4 (8.3 x 11.7 in. / 21 x 30 cm) 

• A5 (5.8 x 8.3 in. / 15 x 21 cm)
• A6 (4.1 x 5.8 in. / 11 x 15 cm)
• B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm.

Envelope sizes
The printer accepts the following envelope sizes:

• C5 (6.7 x 9 in. / 16 x 23 cm)

• C6 (4.5 x 6.4 in. / 11 x 16 cm)

• DL (4.3 x 8.7 in. / 11 x 22 cm)

• US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

• US #9 (3.9 x 8.9 in. / 10 x 23 cm)

• US #10 (4.1 x 9.5 in. / 10 x 24 cm)

IMPORTANT: Do not load envelopes with cutout or clear windows. 

Minimum size Maximum size

English units 4 x 6 in. 8.5 x 14 in.

Metric units 10 x 15 cm 22 x 36 cm
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Loading paper
To load paper: 

1. Open and lift the paper input tray. 

2. Pull out the paper output tray and the extender until they are fully extended. 
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Loading plain paper
The capacity of the paper input tray is 150 sheets of plain paper.

To load plain paper: 

1. Fan and stack the paper.

2. Make sure the left and right paper-edge guides are in the far left and far right 
positions, then insert the paper into the input tray. 

3. Move the paper-edge guides until they touch the paper. 
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Loading photo paper 
The capacity of the paper input tray is 20 sheets of photo paper.

To load photo paper: 

1. Remove any paper from the input tray.

2. Insert the photo paper (short side first) into the center of the input tray with the 
logo side toward the tray and the glossy side toward you.

IMPORTANT: Always load the paper short side first. The printer automatically detects 
the orientation of the picture, whether it’s portrait or landscape, and prints 
accordingly. If the photo paper is loaded in the wrong direction, the image 
will be cut off and the paper may jam. If the paper is loaded with the wrong 
side up, the image quality will be affected. 

3. Move the paper-edge guides until they touch the paper. 
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Loading envelopes
The capacity of the paper input tray is 20 envelopes.

IMPORTANT: Do not load envelopes with cutout or clear windows. 

To load envelopes: 

1. Remove any paper from the input tray.

2. Insert the envelope(s) into the tray with the with the flap side toward the tray 
and the top of the envelope against the right side of the tray.

3. Move the paper-edge guides until they touch the envelope(s). 
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Loading originals
You can place originals for copying, scanning, or faxing on the scanner glass or in the 
ADF (Automatic Document Feeder). The ADF automatically feeds the originals into 
the printer when you begin copying, scanning, or faxing.

NOTE: Keep the scanner glass clean. Any dirt or smudges on the glass will appear 
as marks on the copy. See Cleaning the scanner glass and document 
backing, page 96.

Using the scanner glass

To place an original on the scanner glass:

1. Remove any originals from the Automatic Document Feeder (ADF).

2. Lift the scanner lid, and place the document or picture face down in the 
right-front corner.

3. Close the scanner lid. 
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Using the Automatic Document Feeder (ADF)
You can load up to 25 originals (20 to 24 lb / 75 to 90 gsm plain paper) in the 
Automatic Document Feeder (ADF). 

The ADF accepts originals in the following sizes:

IMPORTANT: Do not load photographs, cards, or any paper stock heavier than 
24 lb / 90 gsm or lighter than 16 lb / 60 gsm in the ADF.

1. Remove any originals from the scanner glass.

2. Move the ADF paper-edge guides outward. 

3. Fan and stack the originals, then insert them face up in the ADF, with the top of 
the pages in first.

IMPORTANT: Remove all paper clips and staples from the originals.

4. Move the ADF paper-edge guides until they touch the paper. 

The ADF automatically feeds the originals into the printer when you begin copying, 
scanning, or faxing. 

Minimum size Maximum size

English units 6.9 x 9.8 in. 8.5 x 14 in.

Metric units 176 x 250 mm 216 x 356 mm

ADF paper-edge guides

Automatic Document 
Feeder (ADF)
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5 Printing 
Print documents and lab-quality pictures on your printer. 

Printing documents
To print a document from your computer: 

1. Open the document. 

2. Select File > Print.

3. In the Print dialog box, select your KODAK Printer. 

4. Choose the pages to print, number of copies, etc, then click OK (on a computer 
with WINDOWS OS) or Print (on a computer with MAC OS). 

Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts (see 
Paper sizes, page 36) by rotating the paper manually and reloading the paper after 
the first side is printed. 

IMPORTANT: Two-sided printing can only be done on media that can absorb ink on both 
sides, such as plain paper or two-sided photo paper. Two-sided printing will 
not work on bar-coded photo paper (the bar code is on the back side).

Printing two-sided documents from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS: 

1. Load paper into the paper input tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that your KODAK ESP Office 2150 Series is 
selected (printers with a wireless connection have a 4-digit number added to 
the end of the name), then click Properties. 

4. Select the Layout tab. 

5. In the Two-sided printing field, select Manual (Instructions provided). 

6. Under Flip on, select either Long edge or Short edge.

7. Click OK to close the Properties window. 

8. Click OK or Print to start printing.

9. When a message appears on your computer or printer LCD telling you to do so, 
remove the printed pages from the output tray.

10. Turn the printed pages over, and place them into the paper input tray (top edge 
down and printed side away from you). 

11. Press Start Black or Start Color on the printer. 

NOTE: It does not matter which Start button you press; the print job will continue 
printing in either color or black, depending on the document. 
www.kodak.com/go/aiosupport  43



Printing
Printing two-sided documents from a computer with MAC OS

To print two-sided documents from a computer with MAC OS: 

1. Load paper into the paper input tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that KODAK ESP Office 2150 Series Printer (or 
for a wireless connection, KodakESPOffice2150+XXXX, where XXXX is a 
number) is selected. 

4. Continue with the next steps, depending on the version of Home Center 
Software you have.

v6.1 v6.2 or higher

5. In the Copies & Pages list, select 
Paper Handling.

6. In the Pages to Print list, select Odd 
Only.

7. In the Page Order list, select 
Normal.

8. Click Print.
9. When the odd-numbered pages 

have finished printing, remove 
them from the output tray.

10.Turn the printed pages over, and 
place them into the paper input 
tray (top edge down and printed 
side away from you).

11. Select File > Print.
12.In the Copies & Pages list, select 

Paper Handling.
13.In the Pages to Print list, select 

Even Only.
14.In the Page Order list, select 

Normal.
15.Click Print.

5. In the Print dialog box, select the 
two-sided check box.

6. Click Print.
7. When the even-numbered pages 

have finished printing, follow the 
instructions on the printer LCD to 
reload the printed pages in the 
paper input tray.

8. Press Start Black or Start Color on 
the printer control panel to print 
the odd-numbered pages.

NOTE: It does not matter which Start 
button you press; the print job 
will continue printing in either 
color or black-and-white, 
depending on the document. 
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Printing forms from the control panel
You can print the following forms from the printer control panel:

• Graph Paper

• Wide Ruled

• Narrow Ruled

• Grocery List

• Reminder List

• Tic-tac-toe

• Sheet Music (Portrait)

• Sheet Music (Landscape)

To print a form:

1. Press Home.

2. Press  to select Printable Forms, then press OK.

3. Press  to select a form. 

4. Press or  to select a quantity (up to 99), then press OK. 

5. Press Start Black or Start Color on the printer. 

NOTE: It does not matter which Start button you press; the form will print in either 
color or black, depending on the form. 

Printing pictures
You can print pictures with your all-in-one printer from: 

• A memory card inserted into a memory card slot

• A storage device (such as a flash drive) or digital camera connected to the front 
USB port with a USB cable (KODAK ESP Office 2170 printer only)

• An iPhone, iPod touch, iPad, BLACKBERRY Device, or ANDROID OS Device 
(may not be available with all models). For information, go to 
www.kodak.com/go/mobile. 

You can also print pictures using Home Center Software from your computer with 
WINDOWS OS. Home Center Software lets you edit and enhance your pictures 
quickly. Open Home Center Software, select Edit and Print Pictures, then follow the 
on-screen instructions.

On a computer with MAC OS or WINDOWS OS, you can print pictures from 
KODAK EASYSHARE Software or any picture-editing or photo-management 
software. 
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Printing
Viewing pictures on a memory card or USB-connected device

NOTE: The option to use a USB-connected device, such as a digital camera or USB 
flash drive, is available only on the ESP Office 2170 printer.

When you insert a memory card into the memory card slot on your printer or a 
USB-connected device into the USB port, the pictures on the card or device appear 
on the LCD. Press or  to scroll through the pictures. 

If the printer is idle for more than two minutes, the LCD will revert to the status 
display. To view the pictures again, press any button, then press or .

Finding pictures on a memory card or USB-connected device

Your printer can help you locate pictures on a memory card or USB-connected 
device by the date the picture was taken or last saved. 

To locate pictures:

1. Insert the memory card into the memory card slot or connect the USB device to 
the front USB port (ESP Office 2170 printer only).

2. Press Home.

3. Press  to select View / Print Photos, then press OK.

4. Press  to select Find Photos, then press OK.

5. In the View by Date menu, press  to select Year, Month, and/or Day; press 
or  to select the specific year, month, and/or day. 

The number of photos found for the date you specified appears under the menu 
name. 

6. Press OK to view the pictures.
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Printing from a memory card or USB-connected device
You can print pictures from the following cards or USB-connected devices (ESP 
Office 2170 printer only):

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove 
the adapter and the memory card as a unit; do not remove the memory card 
while leaving the adapter in the printer.

MS/XD/SD Card slot Front USB port
(on ESP Office 2170 printer only)

• MULTIMEDIA Card (MMC)
• XD Picture Card
• SECURE DIGITAL (SD) Card 
• SECURE DIGITAL High Capacity 

(SDHC) Card
• MEMORY STICK
• Variations of the memory cards above 

that require an adapter (for example, 
MEMORY STICK Duo, miniSD, and 
microSD)

• PICTBRIDGE Technology enabled 
camera

• Flash drive
• MSC Cameras (cameras as USB 

storage device)

memory card slot

front USB port 
(ESP Office 2170 
printer only)
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Using default settings to print a picture

Unless you change the default settings, the default for printing pictures is one
4 x 6 in. / 10 x 15 cm picture. (To change the default settings, see Save as Defaults, 
page 50.) 

To print a picture from a memory card or USB-connected device (ESP Office 2170 
printer only) using the default settings: 

1. Load photo paper (see Loading photo paper, page 39).

2. Insert the memory card into the memory card slot, or connect a digital camera 
or USB flash drive to the front USB port. 

IMPORTANT: Do not use the memory card slot and the USB port at the same time.

3. Press or  to select the picture you want to print. 

4. Press Start Black to print a black-and-white picture, or Start Color to print a 
color picture.

The printer prints a single 4 x 6 in. / 10 x 15 cm picture. 

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, 
do not remove it from the printer while printing.

memory card slot

front USB port 
(ESP Office 2170
printer only)
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Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of 
pictures, or you can change the settings and save them as the default. 

To print a picture or pictures using settings other than the default settings: 

1. Insert the memory card into the memory card slot, or connect a digital camera 
or USB flash drive to the front USB port (ESP Office 2170 printer only). A picture 
appears on the LCD. 

IMPORTANT: Do not use the memory card slot and the USB port at the same time. 

2. Press or  to select the picture you want to print, then press OK. 

3. Repeat step 3 for each picture you want to print.

4. Press Back for Remote Printing Settings. 

5. Press  to select an option (see table below), then press or  to change the 
setting. 

memory card slot

front USB port 
(ESP Office 2170
 printer only)

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the memory 
card or, with ESP Office 2170 printers only, 
the USB flash drive or connected digital 
camera; press OK to select the picture for 
printing; press Back to display the Print 
Photos Options menu. 

Find Photos -- Press OK, then select a year, month, and/or 
day to view photos by the date that they 
were taken; press OK to view the photo(s); 
press Back to display the Print Photos 
Options menu.
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NOTE: You can also adjust the print photo options using the Online Printer 
Management Tool. When viewing the tool in your browser (see Accessing 
the Online Printer Management Tool, page 15), select the Settings tab, then 
select Copy & Print > Print Photo.

6. When you have finished changing settings, press Start Black to print a 
black-and-white picture, or Start Color to print a color picture.

IMPORTANT: To prevent loss of data from your memory card, camera, or USB flash drive, 
do not remove it from the printer while printing.

Transfer All to PC -- Your printer and computer must be 
connected with a USB cable. To transfer all 
the pictures on the memory card to your 
computer, press OK then press Start Black 
or Start Color. (It does not matter which 
Start button you press.)

Quantity 1 (default) to 99 The number of copies that print.

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected print size is smaller than the 
paper in the paper input tray, the printer 
automatically arranges the pictures to best fit 
the paper size. 

Plain Paper Quality Normal (default) Good quality output; prints faster than Best.

Best The highest quality, but the slowest print 
speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto. 
(default)

The printer detects when you load photo 
paper and sets Best quality automatically.

Scene Balance On (default)
Off 

Adjusts the image brightness to correct for 
underexposure and reduces the variation in 
contrast in different areas of the picture.

Add Date to Prints No (default)
Yes

Prints the date the picture was taken or last 
edited in a corner of the print.

Save as Defaults No / Yes To save the settings as the new default, press 
OK. With Yes selected, press OK.

Print Photos Option Settings Description
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Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for 
printing. This creates a tag that is recognized by the printer. If you choose to print 
tagged pictures, they will print according to the default settings on your printer 
(unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports 
tagged pictures (may also be called “marked” or “DPOF”) functionality.

To print tagged pictures:

NOTE: Make sure Tagged Images Printing is On (see Configuring printer settings, 
page 5). 

1. Insert the memory card into the memory card slot or connect a camera to the 
front USB port (ESP Office 2170 printers only). 

2. When the “Print tagged images?” message appears, press Start Black to print a 
black-and-white picture, or Start Color to print a color picture. 

memory card slot

front USB port (ESP 
Office 2170 printers 
only)
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Printing panoramic pictures

To print a panoramic picture, load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 
paper in the paper input tray.

1. Insert the memory card into the memory card slot, or connect a digital camera 
or USB flash drive to the front USB port (ESP Office 2170 printer only). 

2. Press or  to find the panoramic picture you want to print, then press OK.

3. Press Back for Remote Printing Settings. 

4. Press  to select Print Size, then press  to select 4 x 12.

5. Press Start Black to print a black-and-white picture, or Start Color to print a 
color picture. 

IMPORTANT: To prevent loss of data from your memory card, camera, or USB flash drive, 
do not remove it from the printer while printing.

Printing from a wireless device

You can print pictures wirelessly at the touch of a button from:

• iPhone (iOS 3.0 or later)

• iPod touch (2nd generation)

• iPad

• BLACKBERRY Device (software v4.5 or later)

• a device running ANDROID OS v2.0 or later

For more information, see Mobile Printing, page 54. 

memory card slot

front USB port 
(ESP Office 2170 
printer only)
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Transferring pictures to a computer
You can transfer your image files from a memory card in the printer or from a 
USB-connected device (ESP Office 2170 printers only) to your computer. To transfer 
these files, the printer must be connected to your computer with a USB cable.

NOTE: If you have large video files or a large number of pictures (400 or more), we 
recommend that you transfer them using a memory card reader attached 
directly to your computer. 

Transferring pictures to a computer with WINDOWS OS
1. Insert the memory card into the memory card slot, or connect a digital camera 

or USB flash drive to the front USB port (ESP Office 2170 printer only).

2. Press Back.

3. Press  to select Transfer All to PC, then press OK. 

4. Press Start Black or Start Color. 

NOTE: It does not matter which Start button you press. 

5. If your computer is connected to a wireless network and with a USB cable, select 
the USB-connected printer (no number after the printer name). 

6. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS
1. Insert the memory card into the memory card slot on the printer, or connect a 

digital camera or USB flash drive to the front USB port (ESP Office 2170 printers 
only). 

2. Press Back.

3. Press  to select Transfer All to PC, then press OK. 

4. Press Start Black or Start Color. 

NOTE: It does not matter which Start button you press. 

5. If your computer is connected to a wireless network and with a USB cable, select 
the USB-connected printer (no number after the printer name). 

6. Use iPhoto or Image Capture on your computer to complete the transfer.
NOTE: You can adjust the Photo print settings using the Online Printer 

Management Tool. When viewing the tool in your browser (see Accessing 
the Online Printer Management Tool, page 15), select the Settings tab, then 
select Copy & Print > Print Photo.
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6 Mobile Printing
Mobile printing lets you print to your all-in-one printer from your Web-connected 
mobile device. 

When your:

• printer is registered to Google Cloud Print, you can print from anywhere with 
your mobile device using Google Cloud Print apps.

• printer has an email address (assigned by KODAK Email Print Service), you can 
send emails and email attachments to your printer from anywhere, from a 
device capable of sending email.

• mobile device is connected to the same wireless network as your printer, you 
can print pictures using a KODAK Pic Flick App.

When you plan to use mobile printing, make sure that your printer power is on or 
your printer is in low power mode (for information, see Time to Low Power under 
Configuring printer settings, page 5). 

Printing using Google Cloud Print
Print on the go from your smartphone, computer, or tablet using Google Cloud Print 
enabled apps. 

Before you can use Google Cloud Print, make sure your printer is set up for Google 
Cloud Print. See Setting up Cloud Printing, page 30.

Printing varies by application. For the latest update, go to 
www.google.com/cloudprint/learn/apps.html.

To print from a Chromebook:

Click the wrench and select Print to print the Web page you are viewing (you can 
also use the keyboard shortcut Ctrl+P). 

To print from an iOS mobile device (iPhone, iPad, iPod touch): 

• From GMAIL:

– Email body: Select the email, then click the menu in the top-right corner and 
select Print. 

– Attachment: Click the Print button next to the attachment. 

• From Google Docs: 

– Select the document, then click the menu in the top-right corner and select 
Print. 

To print from an ANDROID OS Device:

Install the Google Cloud Print App from the ANDROID Market. 
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To print from a computer:

Install the Chrome extension (plug in) from the Chrome Web store, then: 

• From GMAIL:

– Email body: Select the email, then click the Print all using Google Cloud Print 
link at the top right of the email. 

– Attachment: Select Print attachment using Google Cloud Print. 

• From Google Docs: 

– Select File > Print using Google Cloud Print. 

• Web pages (URL must end with .pdf, .doc, or .txt): 

– Click Print using Google Cloud Print when it appears on the URL address bar. 
– For the latest information on supported formats, go to the Chrome extension 

(plug in) Web site. 

To print from a BLACKBERRY OS Device:

We recommend you use KODAK Email Print. 

Printing using KODAK Email Print Service

Printing emails, documents, and pictures

KODAK Email Print lets you send emails and email attachments (documents and 
pictures) to your printer from anywhere, using any device capable of sending email. 

NOTE: Before you can use KODAK Email Print, your printer must be registered to 
Google Cloud Print (see Setting up Cloud Printing, page 30), and your 
printer must have an email address assigned by KODAK Email Print (see 
Registering your printer with KODAK Email Print Service, page 31).

To print using KODAK Email Print:

1. Make sure that your device or computer is connected to the Internet.

2. Open an email application (such as GMAIL, MICROSOFT OUTLOOK, 
HOTMAIL, YAHOO, iOS Mail, ANDROID OS Mail).

3. Write your email and attach the file(s) you would like to print.

4. Send the email to your printer email address. 

The email body and attachments will print to your printer. 

NOTE: If your printer has a photo paper tray, .jpg files attached to your email will 
automatically print to the photo paper tray, and documents will print to the 
main paper tray.
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Mobile Printing
Printing pictures from a mobile device
When connected to the same Wi-Fi network, you can print pictures wirelessly with 
your all-in-one printer from: 

• an iPhone (iOS 3.0 or later), iPod touch device (2nd generation), iPad (may not 
be available with all models).

• a BLACKBERRY Device (software v4.5 or later).

• a device running ANDROID OS v2.0 or later.

Download the KODAK Pic Flick App from the App Store directly from your device, 
then follow the procedure for your device. For information, go to 
www.kodak.com/go/mobile.

Printing pictures from an iPhone, iPad, or iPod touch device
IMPORTANT: Requires iOS 3.0 or later. 

To print a picture from an iPhone, iPad, or iPod touch device (2nd generation):

1. Make sure your device is connected to the same Wi-Fi network as your printer.

2. Open the KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print, then select Choose Device.

4. Select your KODAK All-in-One Printer from the list of available devices.

5. Select Send.

Printing pictures from a BLACKBERRY Device

To print a picture from a BLACKBERRY Device (software v4.5 or later):

1. Make sure your BLACKBERRY Device is connected to the same Wi-Fi network 
as your printer.

2. Open the KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print.

4. Press the Menu key, then select Print. 

5. Select your KODAK All-in-One Printer from the list of available devices.

NOTE: It may take a few minutes for the printer to appear in the Available 
Printers list.

6. Select the print size and enter the number of copies.

7. Select Print.
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Printing pictures from an ANDROID OS Device

To print a picture from a device running ANDROID OS v2.0 or later:

1. Make sure your device is connected to the same Wi-Fi network as your printer.

2. Open the KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print.

4. Select View/Edit to edit the picture(s), or go to step 5.

a. Press and hold the screen to enter the edit mode.

b. Rotate, move, pan, zoom, or crop the picture. 

5. Press Select Device, then select your KODAK All-in-One Printer.

6. Select the print size.

7. Press Back, then select Send.
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7 Copying
You can copy documents and photos with your all-in-one printer. The printer 
produces high-quality color or black-and-white copies on a variety of paper types 
(see Paper types, page 35). 

Loading originals for copying
To copy documents (up to 25 pages) on plain paper, load the original(s) in the 
Automatic Document Feeder (ADF). 

IMPORTANT: The ADF accepts plain paper originals from 6.9 to 8.5 in. (18 to 22 cm) wide 
and 9.8 to 14 in. (25 to 36 cm) long.

To copy a photo, documents on thick paper, or a document that is too small or too 
large to fit in the ADF, place the original face down on the scanner glass.

For more information on loading originals, see Loading originals, page 41.

Copying a document
You can copy a document using the default settings, or you can adjust the quantity, 
size, quality, and brightness of your copies. 

Using the default settings to copy a document 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 107), or defaults that you have set on the printer (see the bottom of 
the table under Adjusting the settings and copying a document, page 59). 

To copy a document using the current default settings:

1. Place the original document in the ADF or on the scanner glass.

2. Press Copy.

3. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 

NOTE: If you load the original document in the ADF, the ADF automatically feeds 
the document into the printer when you begin copying. 
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Adjusting the settings and copying a document
To copy a document using settings other than the default settings:

1. Place the original document in the ADF or on the scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Press  to select an option, then press or  to change the setting.

4. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 

Copy Document 
Option

Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and the 
size of the paper in the paper tray, and 
automatically reduces or enlarges the 
original so that the copy fits on the 
paper.

20% to 500% Reduces up to 20% or enlarges up to 
500% of the original size.

Plain Paper Quality Normal
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto. 
(default)

The printer detects photo paper in the 
paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to +3 
(Normal is default) 

Lightens or darkens the copy. 
Normal is no change from the original; 
-3 is the darkest; +3 is the lightest.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes selected, 
press OK.
www.kodak.com/go/aiosupport 59



Copying
Changing the number of copies of a document
To change the number of copies:

1. Place the original document in the automatic document feeder (ADF) or on the 
scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Make sure Quantity is selected. 

4. Press  or  to select a number, or use the numeric keypad to enter the 
number of copies. 

5. Press Start Black to make black-and-white copies, or press Start Color to make 
color copies. 

Enlarging or reducing the size of a copy

To enlarge or reduce the size of the copy:

1. Place the original document in the automatic document feeder (ADF) or on the 
scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Press  to select Copy Size.

4. Press  or  to select an enlargement or reduction.

5. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 

Darkening or lightening a copy

To darken or lighten the copy:

1. Place the original document in the automatic document feeder (ADF) or on the 
scanner glass.

2. Press Copy. 

The Copy Document Options menu appears on the LCD. 

3. Press  to select Brightness.

4. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

5. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 
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Two-sided copying
To make a two-sided copy:

1. Load the paper into the paper tray.

2. Place your original on the scanner glass (see Using the scanner glass, page 41). 

3. Press Copy. 

The Copy Document Options menu appears on the LCD. 

4. If necessary, press  to make changes to copy size, quality, or brightness. 

5. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 

6. Remove the printed page from the output tray, turn the printed page over, and 
place it into the paper input tray (top edge down and printed side away from 
you).

7. Place the next original on the scanner glass. 

8. If necessary, press  to make changes to copy size, quality, or brightness. 

9. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 
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Copying a photo
You can copy a photo using the default settings, or you can make adjustments to the 
quantity, size, quality, and brightness of your copies. 

Using the default settings to copy a photo 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 107), or defaults that you have set on the printer (see the bottom of 
the table under Adjusting the settings and copying a photo, page 63). 

To copy a photo using the current default settings:

1. Lift the scanner lid, and place the original photo face down in the right front 
corner of the scanner glass.

IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF). 

2. Close the scanner lid.

3. Press Home.

4. Press  to select Copy Photo.

5. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 
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Adjusting the settings and copying a photo
To copy a photo using settings other than the default settings: 

1. Lift the scanner lid, and place the original photo face down in the right front 
corner of the scanner glass.

IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF). 

2. Close the scanner lid. 

3. Press Home. 

4. Press  to select Copy Photo, then press OK. 

5. Press  to select an option, then press or  to change the setting. 

Copy Photo Option Settings Description 

Quantity 1 (default) to 99 The number of copies that print.

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12 

8 x 10

8.5 x 11 or A4

The printer enlarges or reduces the 
original to make it the copy size you 
select. 

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size. 

Some cropping may occur if the image 
size and the selected print size are 
different.

Plain Paper Quality  Normal 
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed.

Draft The fastest print speed, but the lowest 
quality.
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6. Press Start Black to make a black-and-white copy, or press Start Color to make a 
color copy. 

Changing the number of copies of a photo

To change the number of copies:

1. Lift the scanner lid, and place the original photo face down in the right front 
corner of the scanner glass.

IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF). 

2. Close the scanner lid. 

3. Press Home.

4. Press  to select Copy Photo, then press OK.

5. Make sure Quantity is selected. 

6. Press  or  to select a number, or use the numeric keypad to enter the 
number of copies. 

7. Press Start Black to make black-and-white copies, or press Start Color to make 
color copies. 

Photo Paper Quality Automatic
(default)

The printer detects photo paper in the 
paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to +3 
(Normal is default) 

Lightens or darkens the copy. 
Normal is no change from the original; 
-3 is the darkest; +3 is the lightest.

Preview No (default) / Yes To see a preview of the photo on the 
LCD, select Yes. 

Save as Defaults No / Yes To save settings as the new default, 
press OK, select Yes, then press OK.

Copy Photo Option Settings Description 
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Enlarging or reducing a photo
To enlarge or reduce the size of the copy:

1. Lift the scanner lid, and place the original photo face down in the right front 
corner of the scanner glass.

IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF). 

2. Close the scanner lid. 

3. Press Home.

4. Press  to select Copy Photo, then press OK.

5. Press  to select Copy Size.

6. Press  or  to select the copy size.

7. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 
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Darkening or lightening a copy of a photo
To darken or lighten the copy of the photo:

1. Lift the scanner lid, and place the original photo face down in the right front 
corner of the scanner glass.

IMPORTANT: Do not load photos in the Automatic Document Feeder (ADF). 

2. Close the scanner lid. 

3. Press Home.

4. Press  to select Copy Photo, then press OK.

5. Press  to select Brightness.

6. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

7. Press Start Black to make a black-and-white copy, or press Start Color to make 
a color copy. 
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8 Scanning
Scanning digitizes documents and pictures, and sends the digital files to your 
computer, memory card, email, network folder, or USB flash drive (ESP Office 2170 
printer only).

To scan to a computer, the Home Center Software must be installed on that 
computer, unless you are using the Online Printer Management Tool. (See Scanning 
from the Online Printer Management Tool, page 77.)

When you scan, the digital file can: 

• open in Home Center Software (when Home Center Software is loaded and the 
printer is connected to a computer with WINDOWS OS).

• open in a third-party scanner software.

• be saved in a format and location that you determine (see Changing the scan 
settings for scanning from the printer control panel, page 67).

Scanning from a software program on the computer (such as Home Center 
Software) gives you more options, but you can also scan from the printer control 
panel.

Before you begin scanning
If you are scanning to a computer, make sure that the printer is connected to the 
computer using a USB cable or wireless network (see Networking Your Printer, 
page 6).

If you want to scan to an email address or to a shared network folder, you need to: 

• make sure the printer is connected to a computer using a wireless connection.

• set up profiles using the Online Printer Management Tool (see Setting up Scan 
To Email, page 20 and Setting up Scan To Network Folder, page 26).

Changing the scan settings for scanning from the printer control panel

Before you scan from the printer control panel, you must adjust the scan settings.

NOTE: These settings apply only to Scan to Computer, Scan to Memory Card, or 
Scan to USB Flash Drive (ESP Office 2170 printer only) from the printer 
control panel. The settings do not apply to Scan to Email or Scan to Network 
Folder. To change scan setting for scanning to email or to network folder, see 
Setting options for scan to email, page 24 or Setting scan settings for scan to 
network folder, page 29.

1. Open Home Center Software.

2. Select Printer Tools on a computer with WINDOWS OS, or Tools on a computer 
with MAC OS.

NOTE: To get to Printer Tools without Home Center Software (WINDOWS OS 
only), select Start > All Programs > Kodak > KODAK AiO Printer Tools.

3. Under the Tools heading, select Printer Scan Settings. 
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4. Adjust settings for scanning documents and pictures:

a. To select a program that scanned images or documents will appear in when 
you scan from the printer control panel: 

(1)Select the General tab.

(2)Under the Program List heading, click  next to the currently selected 
program.

(3) From the list, select the program in which you want the scanned files to 
open. 

b. To adjust settings for scanning documents, select the Document tab, then 
select an option for each setting:

c. To adjust settings for scanning pictures, select the Picture tab, then select an 
option for each setting:

Setting Options

File format .pdf 
.rtf (available only when connected to a computer 

with WINDOWS OS)
.tif 

.jpg

.bmp (available only when connected to a computer 
with MAC OS)

Resolution (dpi) 75
150
200 
300

File Save Prompt for File Name and Location
Automatically Save - specify:
• Base name; by default, scanned files are named 

“scan1”, “scan2”, and so on.
• Location (folder) where the scanned files will be 

saved

Setting Options

File format .jpg
.bmp
.tif

Resolution (dpi) 75
150
200

300

600
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NOTE: Before you save a scanned file in Home Center Software, you can 
preview, crop and sharpen the image, and adjust the color. On a 
computer with WINDOWS OS, see the Home Center Software Help 
(? icon) for instructions.

5. When you are finished making selections, click OK on the bottom right of the 
Printer Scan Settings window. 

6. Close the Printer Tools window. 

Quality When connected to a computer with WINDOWS 
OS:

• Best for E-mail
• Normal
• High
• Maximum
When connected to a computer with MAC OS, 
a slider bar with:
• Least
• Medium
• Best

Automatically Detect 
Pictures (when connected 
to a computer with 
WINDOWS OS) or Auto 
Crop (when connected to a 
computer with MAC OS)

When selected, multiple pictures placed on the 
scanner glass are saved as separate files.

File Save Prompt for File Name and Location
Automatically Save - specify:
• Base name; by default, scanned files are named 

“scan1”, “scan2”, and so on.
• Location (folder) where the scanned files will be 

saved

Setting Options
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Loading originals for scanning
To scan documents (up to 25 pages) on plain paper, load the original(s) in the 
automatic document feeder (ADF). 

IMPORTANT: The ADF accepts plain paper originals from 6.9 to 8.5 in. (18 to 22 cm) wide 
and 9.8 to 14 in. (25 to 36 cm) long.

To scan a photo, documents on thick paper, or a document that is too small or too 
large to fit in the ADF, place the original on the scanner glass.

For more information on loading originals, see Loading originals, page 41.

Scanning from the printer control panel
When you scan a document or picture(s) from the control panel, you have the 
following options: 

• Scan to Computer - scans to a file or to Home Center Software on your 
computer

• Scan to Memory Card - scans to a memory card in the memory card slot 

• Scan to USB Flash Drive - scans to a flash drive attached to the front USB port

• Scan to Email* - scans to an email address that you select from the Email Profile 
you set up in the Online Printer Management Tool 

• Scan to Network Folder* - scans to a shared network folder that you designated 
in the Online Printer Management Tool

* Before you can use these options, you must set up Scan to Email (see Setting up 
Scan To Email, page 20) and Scan to Network Folder (see Setting up Scan To 
Network Folder, page 26) from the Online Printer Management Tool. 
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Scanning to a computer
To scan to a computer: 

1. Load the original(s) (see Loading originals for scanning, page 70).

2. Press Scan on the printer control panel.

3. Select Scan to Computer, then press OK. 

4. Press  to select an option, then press or  to change the setting.

5. Press Start Black to make a black-and-white scan, or press Start Color to make 
a color scan. The scanned file appears at the destination you specified.

Scan 
Option

Settings Description

Scan To USB-connected 
Computer
(default)

The scanned file is sent to the USB-connected 
computer.

Name of computer 
(only if a computer is 
connected by 
wireless or Ethernet 
network)

The scanned file is sent to the computer on the 
wireless or Ethernet network.

Original 1-sided (default) Original document is printed on one side

2-sided Original document is printed on both sides of 
the page. Select this only if you are scanning 
both sides of the page and have loaded the 
document into the ADF.

Scan What Document
(default)

Sets the scan settings for scanning a document 
(see Changing the scan settings for scanning 
from the printer control panel, page 67). 

Photo Sets the scan settings for scanning a picture 
(see Changing the scan settings for scanning 
from the printer control panel, page 67).

Destination File
(default)

Sends the scanned file in the format and to the 
location on your computer that you designate.

Application 
(available only when 
Home Center 
Software is installed 
on computer)

Sends the scanned file to Home Center 
Software.

Save as 
Defaults

No / Yes To save the settings as the new default, press 
OK. With Yes selected, press OK.
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Scanning to a memory card or USB flash drive
To scan to a memory card or USB flash drive: 

1. Load the original(s) (see Loading originals for scanning, page 70).

2. Press Scan on the printer control panel. 

3. Press  to select Scan to Memory Card or Scan to USB Flash Drive, then press 
OK.

4. Press  to select an option, then press or  to change the setting.

5. Press Start Black to make a black-and-white scan, or press Start Color to make 
a color scan. The scanned file appears at the destination you specified. 

Scan Option Settings Description

Scan What Photo
(default)

Sets the scan settings for scanning a picture 
(see Changing the scan settings for scanning 
from the printer control panel, page 67). 

Document Sets the scan settings for scanning a document 
(see Changing the scan settings for scanning 
from the printer control panel, page 67).

File Type JPG (default) The scanned file is saved as a JPG.

Single-page PDF The scanned file is saved as a single-page PDF.

Multi-page PDF The scanned file is saved as a multiple-page PDF.

Original 1-sided (default) Original document is printed on one side.

2-sided Original document is printed on both sides of the 
page. Select this only if you are scanning both 
sides of the page and have loaded the document 
into the ADF.

Scan Size Auto (default)
2 x 3
3.5 x 5
4 x 6
4 x 7
4 x 8
5 x 7
4 x 12
8 x 10
8.5 x 11
A4
8.5 x 14

Determines the size that is scanned.

Save as 
Defaults

No / Yes To save the settings as the new default, press 
OK. With Yes selected, press OK.
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Scanning to email
You can scan your original and immediately send the scanned file by email to one or 
more recipients directly from the printer. 

NOTE: You must first use the Online Printer Management Tool to set up scanning to 
email options (see Setting up Scan To Email, page 20).

1. Load the original. 

2. Press Scan on the printer control panel.

3. Press  to select Scan To Email, then press OK. 

4. Select an outgoing email profile (the person from whom the email with the scan 
attachment is sent), then press OK.

5. If necessary, enter the 4-digit PIN number (that you entered during Setting up 
Scan To Email, page 20), select Done, then press OK.

6. Select an email recipient, then press OK.

7. Repeat step 6 for each recipient. 

8. Press Start Black to make a black-and-white scan, or press Start Color to make 
a color scan. 

9. If desired, load another original, then press OK to scan it.

10. Press Start Black or Start Color to send the scan by email. 

NOTE: Pressing either Start button triggers the printer to send the scan. It does 
not matter which Start button you press; whether a scan is color or black 
and white is determined by what you chose in step 8. 
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Scanning to network folder
You can scan your original and immediately send the scanned file to a network folder 
directly from the printer. 

NOTE: You must first use the Online Printer Management Tool to set up scanning to 
network folder options (see Setting up Scan To Network Folder, page 26).

1. Load the original. 

2. Press Scan on the printer control panel.

3. Press  to select Scan to Network Folder, then press OK. 

4. Select Sharing folder, then press OK.

5. If necessary, enter the 4-digit PIN number (that you entered during Setting up 
Scan To Network Folder, page 26), select Done, then press OK. 

6. Press Start Black to make a black-and-white scan, or press Start Color to make 
a color scan. 

7. If desired, load another original, then press OK to scan it.

8. Press Start Black or Start Color to send the scan to a network folder. 

NOTE: Pressing either Start button triggers the printer to send the scan. It does 
not matter which Start button you press; whether a scan is color or black 
and white is determined by what you chose in step 6. 
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Scanning from the computer
To scan a document or a picture: 

1. Load the original.

2. Open Home Center Software, then: 

• on a computer with WINDOWS OS, select Scan Documents and Pictures, 
then follow the on-screen instructions.

• on a computer with MAC OS, select the Tools tab, click Scan Application, 
then follow the on-screen instructions. 

NOTE: If you are not using Home Center Software, open a program that allows you 
to scan, then follow the instructions.

Scanning multiple pictures simultaneously

Using Home Center Software, you can scan multiple pictures simultaneously and 
save them as separate files. 

When scanning multiple pictures, leave space between the pictures so that the 
printer can detect the separate pictures. Any pictures that overlap are interpreted as 
a single picture. 

Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the scanner lid. 

3. Open Home Center Software, then select Printer Tools. 

4. Select Printer Scan Settings, then select the Picture tab. 

5. Select Automatically Detect Pictures, if it is not selected, then click OK.

6. Close the Printer Tools window, then select Scan Documents and Pictures. 

7. Make sure that Picture is selected and Collage - Combine all pictures is cleared, 
then follow the on-screen instructions.

NOTE: Click Help (? icon) for additional instructions. 
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Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the scanner lid. 

3. Open Home Center Software, then select your printer.

4. Select the Tools tab.

5. Click Scan Application.

6. Select Color Picture or Black and White Picture. 

7. Select Automatically detect multiple pictures, if it is not selected.

8. Click Preview or Scan All, then follow the on-screen instructions.

NOTE: Click Help (? icon) for additional instructions. 
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Scanning from the Online Printer Management Tool
You can use an Internet browser to initiate a scan from the Online Printer 
Management Tool on a computer that is connected to the same network as the 
printer.

1. Open the Online Printer Management Tool in a browser (see Accessing the 
Online Printer Management Tool, page 15).

2. Select the Applications tab. 

3. Select Applications > Webscan. 

4. Load the original (see Loading originals for scanning, page 70).

5. Select the type of scan you want.

a. Select Picture or Document.

b. Select Color or Black & White.

6. Click Preview to see what will be scanned.

• If needed, click Clear to reposition the original.

7. When you are satisfied with the preview, click Scan. The scanned file will display 
in a new browser window.

8. In the new browser window, select File > Save As to save the file as a JPEG 
image on your computer. 
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9 Faxing
Your printer can send and receive faxes in either black-and-white or color. 

Before you begin faxing
Before you can send or receive faxes, you must connect your printer and set up the 
fax options.

Connecting the printer for faxing

Selecting the country/region

For the fax to work properly, the country or region selected on the printer must 
match your location. This setting determines how your faxes are sent and received. 

To set the correct country or region:

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select Country/Region, then press OK.

4. Press  to select your country or region, then press OK.

Determining your telephone system type

The instructions for setting up your printer for faxing differ depending on the type of 
telephone service you have. Determine the type of telephone service you have, and 
connect your printer accordingly. 

IMPORTANT: Use the phone cord that was provided with the printer. If you use any other 
phone cord, you may not be able to send or receive faxes successfully.

• Standard telephone service — telephone service that uses dedicated telephone 
wiring to transmit only phone signals 

• Cable telephone service — telephone service that is delivered by a cable 
television service

• Digital Subscriber Line (DSL) — telephone service that uses the wires of a local 
telephone network to transmit digital data over cables

• Internet telephone service (Voice-Over-Internet-Protocol or VOIP) — 
telephone service delivered by an Internet provider 
78 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Connecting to a 
Standard or Cable 
telephone service 

If you have Standard or Cable telephone service, connect one end of the phone cord 
that came with the printer into the LINE IN port on the back of the printer and the 
other end into the wall phone jack.

Connecting to a 
Digital Subscriber 
Line (DSL) 

If you have DSL telephone service, connect one end of the phone cord that came 
with the printer into the LINE IN port on the back of the printer and the other end 
into the DSL filter (available from your DSL provider), which is connected to the wall 
phone jack. 

NOTE: You must use a DSL filter to transmit fax signals properly to your printer.

DSL filter
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Connecting to 
Internet telephone 
service 
(Voice-Over-Internet 
Protocol or VOIP)

If you have Internet telephone service, you should already have a cable 
modem/router connected to the cable outlet with a coaxial cable. You will also need 
an Analog Telephone Adapter (ATA) to connect your printer for faxing. 

NOTE: Sometimes the cable modem/router has a built-in ATA. Contact your cable 
telephone service provider for more information. 

1. Connect an RJ-45 (also called CAT 5) cable from the cable modem/router to the 
WAN port on the Analog Telephone Adapter (ATA). 

2. Connect one end of the phone cord that came with the printer (RJ-11 telephone 
cord) to one of the phone input ports on the ATA and the other end to the LINE 
IN port on the back of your printer. 

Coaxial 

RJ-45 cable 
RJ-11 

Cable outlet

Cable 

Analog Telephone 

modem/router

Adapter (ATA)

(CAT 5 cable)
telephone cord

cable
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Determining whether your phone line is dedicated or shared

To connect your printer for faxing correctly, you need to determine whether your 
phone line is shared or dedicated.

• A dedicated phone line is one that has only this printer and no other devices 
connected to it. If you have a dedicated line, connect your printer as described 
for your type of phone service (see Connecting to a Standard or Cable telephone 
service, page 79, Connecting to a Digital Subscriber Line (DSL), page 79, or 
Connecting to Internet telephone service (Voice-Over-Internet Protocol or 
VOIP), page 80). 

• A shared phone line is one that has several devices connected to it, such as a 
phone and/or answering machine as well as the printer. If you have a shared line, 
connect your printer in one of the following ways, based on the devices you have 
connected to the same phone line. 

If you share the line with an answering machine or telephone:

1. Connect one end of the phone cord that came with the printer into the LINE IN 
port on the back of the printer.

2. Connect the other end of the phone cord into a wall phone jack, DSL filter, or 
ATA, depending on the type of telephone service you use.

3. Connect one end of the phone cord for your answering machine into the EXT 
OUT port on the back of the printer.

4. Connect the other end of the phone cord into the answering machine or 
telephone.

NOTE: If you have an answering machine, set the number of rings to answer on the 
printer to a higher number than the rings to answer for the answering 
machine (see Rings to Answer under Selecting fax settings, page 83).

Phone with 

Configuration for connecting an answering 
machine with a standard telephone service

answering machine
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If you have an answering service:

If you have an answering service that uses a computerized system for recording 
messages remotely for the same phone line that you use for your all-in-one 
printer, then you can set up a distinctive ring to receive faxes automatically (see 
Distinctive Ring under Selecting fax settings, page 83).

If you do not set up a distinctive ring, you can still receive faxes manually (see 
Receiving a fax manually, page 93). 

Entering fax sender information

Fax sender information appears in the header of any fax that you send from your 
all-in-one printer. Typically this is your name or your business name, your fax 
number, and your phone number. 

NOTE: If you do not enter fax sender information, the header on faxes that you send 
will be blank.

To enter fax sender information:

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. With Fax Sender Information highlighted, press OK. 

4. Use the numeric keypad on the control panel to enter:

• your name or business name

• your fax number

• your phone number

See Using the numeric keypad on the control panel to enter text and/or 
numbers, page 88. 

5. When you are finished entering information in a field, press  to move to the 
next field. 

6. Press OK to save the information. 
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Selecting fax settings
Before sending or receiving faxes, set the fax options. 

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  or  to select an option, then press or  to change the option. 

Fax Setting Options Description

Fax Sender 
Information

-- This information appears on the faxes 
you send. 

Press OK, then enter the fax sender 
name (your name), your fax number, and 
your phone number (see Using the 
numeric keypad on the control panel to 
enter text and/or numbers, page 88); 
press OK to save.

Rings to Answer 1 to 6 (default is 4) The number of times that your phone will 
ring before the printer picks up the call. 

If you use a dedicated phone line for your 
printer, set the Rings to Answer to any 
setting. If the printer shares the phone 
line with an answering machine, set the 
Rings to Answer to a higher number (5 
or 6) than the rings to answer for the 
answering machine (typically 4 rings). 
This allows the answering machine to 
pick up phone calls. The printer will 
monitor the line after the answering 
machine picks up, and, if set to Auto 
Answer, will detect an incoming fax and 
receive it. 

Redial if No Answer Yes (default) / No If the fax number you call does not 
answer, the printer will redial the number 
once automatically. 

Busy Redial 
Attempts

0 to 12

(default is 5)

The number of times that the fax will 
attempt to redial a busy number. 
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Disable Call Waiting No (default) / Yes If you have call-waiting service on your 
phone line, you can disable it so that an 
incoming call does not interrupt your fax 
transmission.

Select Yes to disable call waiting, then 
enter the call waiting disable code 
(below). 

NOTE: You must enable call waiting 
manually after your fax 
transmission.

Call-Waiting Disable 
Code

*70 (default) The printer automatically dials the call 
waiting disable code before dialing the 
number to which you are sending a fax. 
This code disables call waiting for the 
duration of the fax, preventing incoming 
calls from interrupting your fax 
transmission. 

The usual code to disable call waiting is 
the default *70. If the call waiting disable 
code is different in your area, press OK, 
then press  to erase the current code. 
Use the keypad to enter the correct 
code, then press OK. 

Distinctive Ring Any ring (default) / 
Single Ring / Double 
Ring / Triple Ring

This service, available from most phone 
companies, adds multiple phone 
numbers to one phone line. Each phone 
number then has a distinctive ring 
pattern (single, double, or triple ring) to 
let you know which number is ringing. 

Select the ring pattern assigned to the 
phone number for the printer so the 
printer can receive faxes automatically. 

Fax Speed Fast - 33.6K (default)
Medium - 14.4K
Slow - 9.6K

Use this setting to reduce the fax 
transmission speed of your printer. If you 
are having difficulty sending or receiving 
a fax or if your fax works intermittently, 
then reducing the fax speed to Medium 
or Slow may resolve the issue. If you are 
using Vonage or Magic Jack, we 
recommend that you set the fax speed 
to Slow. 

Fax Speaker On (default) / Off The fax speaker allows you to hear the 
dial tone and initial fax tones when 
sending faxes.

Fax Setting Options Description
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Print Fax 
Confirmation Page 

Never (default) / 
Always / After Failure 
Only 

The Fax Confirmation Page contains the 
time and date, the number you called, 
the number you called from, and 
whether the transmission was 
successful. 

Print Fax Settings -- To print the current fax settings, press 
OK. Load letter or A4 paper, then press 
Start Black or Start Color. 

Print Fax Cover Page -- The Fax Cover Page shows the date and 
headings for To and From information for 
your fax. Use this cover page, if needed, 
when sending your fax.

To print a Fax Cover Page, press OK. 
Load letter or A4 paper, then press Start 
Black or Start Color. (The Fax Cover 
Page is black-and-white.)

Print Fax Activity Log -- The Fax Activity Log contains 
information (date, time, duration, 
to/from, number of pages, and more) 
about the last 30 faxes sent and/or 
received.

To print a Fax Activity Log, press OK. 
Load letter or A4 paper, then press Start 
Black or Start Color. 

Dialing Mode Tone (default) / Pulse Determines how the printer dials a fax 
number. 

Tone dialing (the more common 
method) uses tones to dial a phone 
number. It is faster and more reliable 
than pulse dialing, which uses a series of 
pulses to dial a phone number.

Traditionally, pulse dialing was used by 
rotary phones; tone dialing is used by 
touch-tone phones.

Fax Setting Options Description
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To adjust fax settings from the Online Printer Management Tool: 

1. Open the Online Printer Management Tool in a browser (see Accessing the 
Online Printer Management Tool, page 15).

2. Select the Settings tab, then select Fax > Settings. 

3. Change the Sender Information and/or fax Settings as needed.

4. Click Save to update the settings.

Setting the answer mode (auto answer or manual)

The default setting for Auto-Answer is on. When Auto Answer is on, the printer 
picks up all incoming faxes automatically. The green Auto Answer LED is lit when 
Auto Answer is on. 

To answer calls manually, turn off Auto Answer by pressing the Auto Answer button 
so that the green LED is off. (See Receiving a fax manually, page 93.)

Working with the phonebook

You can enter up to 60 fax numbers in the phonebook. 

You can create and manage the phonebook from the printer LCD or, if your printer is 
connected to a computer with WINDOWS OS, you can use Home Center Software. 

You can also use the Online Printer Management Tool to edit the Fax Phone Book. 
See Editing the fax phone book, page 18.

Error Correction On (default) / Off Error correction is applied only when 
sending black-and-white faxes. It 
reduces the loss of data, which can occur 
on poor phone lines. 

Error correction increases the send time 
on poor phone lines, but the 
transmission is more reliable. (Error 
correction does not apply to faxes being 
received.) 

If you are using Vonage or Magic Jack, 
we recommend that you set Error 
Correction to OFF. 

Fax Setting Options Description
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Using symbols in phonebook entries

The following symbols are used in phonebook entries: 

Adding a new phonebook entry

To add a new phonebook entry: 

1. Press Phonebook. 

2. Make sure Edit Phonebook is selected, then press OK. 

3. Make sure Add New Entry is selected, then press OK.

4. Make sure Number is selected, then press OK.

5. Use the numeric keypad on the control panel to enter a fax number, then press 
OK. 

6. With Name selected, press OK.

7. Use the LCD keyboard to enter a name:

8. Optional: Assign a Quick Dial number.

Set up your ten most frequently used fax numbers as Quick Dial numbers. You 
will be able to dial them quickly, and they will be displayed at the top of your 
phonebook. 

a. Press  to select Quick Dial, then press OK.

b. Using the numeric keypad on the control panel, enter a number from 0 to 9, 
then press OK.

9. Press  to select DONE, then press OK.

Symbol Description Response by fax

0 - 9 numbers Dials the number

* star Used for special features (for example, *70 is used to 
deactivate call waiting)

, comma Causes a 2-second delay before dialing the remaining 
numbers

# pound Used for special features (for example, # at the end of a 
number signifies the completion of the number sequence)

a. On the control panel, press , , or 
 to select the letters.

b.When you are finished, select DONE, then 
press OK.
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Editing a phonebook entry

To edit a phonebook entry: 

1. Press Phonebook. 

2. Make sure Edit Phonebook is selected, then press OK. 

3. Press  to select Edit Entry, then press OK.

4. Press  to select the entry you want to edit, then press OK.

5. Press  to select the field you want to edit, then press OK. 

6. Use the LCD keyboard and/or numeric keypad to make your change(s). 

7. Press  to select DONE, then press OK.

Deleting a phonebook entry

To delete a phonebook entry: 

1. Press Phonebook. 

2. Make sure Edit Phonebook is selected, then press OK. 

3. Press  to select Delete Entry, then press OK.

4. Press  to select the entry you want to delete, then press OK.

NOTE: If you do not want to delete the entry, press Cancel.

5. To delete the entry, press OK. 

The entry is deleted from the phonebook.

6. Repeat steps 4 – 5 to delete more entries; when you are finished, press Back or 
Cancel.

Using the numeric keypad on the control panel to enter text and/or numbers

The number keys on the numeric keypad represent a number and several characters. 
For example, the number 2 key also represents the letters A, B, C and a, b, and c. You 
must press the 2 key multiple times to enter a corresponding letter. For example, to 
enter the letter “B” as the first letter of a name, press the 2 key two times; to enter 
the lowercase “b” at the beginning of a name, press the 2 key five times. If the 
lowercase “b” is not at the beginning of a name or word, press the 2 key two times. 

If you need to use the same key for more than one letter in a row (for example, to 
type “Cab”), you need to pause between letters. To type “Cab”, press the 2 key three 
times to enter “C”, then pause 3 to 4 seconds; press the 2 key once to enter “a”, then 
pause for 3 to 4 seconds; and press the 2 key two times to enter “b”. You do not need 
to pause if the next letter is on a different key.

Note that the Symbols (*) key and the Space (#) key also cycle through several 
different symbols when you press the key multiple times. 

To make a correction to your entry, select BKSP on the LCD, then press OK. This 
erases the rightmost character.
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Using the Online Printer Management Tool to edit the Fax Phone Book

You may use the Online Printer Management Tool to edit your fax phonebook. See 
Editing the fax phone book, page 18. 

Preparing a fax for transmission 
Before you send a fax, prepare a cover page (if needed), load the original(s), and 
change the resolution and brightness (if needed). 

Printing a fax cover page

If you need a fax cover page, you can print one with your printer, then manually 
complete the information (person to whom you are sending, fax number, your 
name, etc). 

To print a fax cover page:

1. Press Home.

2. Press  to select Fax Settings, then press OK.

3. Press  to select Print Fax Cover page, then press OK.

4. Load letter or A4 paper, then press Start Black or Start Color to begin printing. 

NOTE: It does not matter which Start button you press; the fax cover prints in 
black-and-white only. 

Loading originals

To fax documents (up to 25 pages) that are on plain paper, load the original(s) face 
up in the Automatic Document Feeder (ADF).

IMPORTANT: The ADF accepts plain paper originals from 6.9 to 8.5 in. (18 to 22 cm) wide 
and 9.8 to 14 in. (25 to 36 cm) long.

To fax a photo, documents on thick or thin paper, or a document that is too small or 
too large to fit in the ADF, place the original face down on the scanner glass. You can 
fax only one page at a time from the scanner glass. 

For more information on loading originals, see Loading originals, page 41.
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Changing resolution and brightness 
Before sending your fax, change the resolution and brightness settings, as needed, 
based on your original.

To modify settings before sending your fax:

1. Press Fax.

2. With Fax Options selected, press OK.

3. Press  to select Resolution. 

The resolution setting determines the amount of detail that is transmitted. 
Select:

• Standard (default) for most documents

• Fine for documents with fine print

• Photo for photographs

4. Press  to select Brightness.

Adjust the brightness setting according to how light or dark your original is. 
Select:

• Normal (default) for most documents

• +1 to +3 to lighten dark originals

• -1 to -3 to darken light originals

NOTE: If you do not want to save these settings for future faxes, send your fax. The 
settings will apply only to the current transmission. If you want to save these 
settings as defaults:

a. Press  to select Save as Defaults, then press OK. 

b. Select Yes, then press OK. 
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Sending a fax
You can send your fax in several ways. You can use: 

• the phonebook

• Quick Dial

• the numeric keypad

• the Redial button

NOTE: If the receiver's fax machine is not set up to print color, the fax will print 
in black-and-white. 

Using the phonebook to send a fax

To send a fax to a number in the phonebook: 

1. Press Phonebook. 

2. Press  to select the desired number. 

3. Press Start Black to send a black-and-white fax or Start Color to send 
a color fax. 

Using Quick Dial to send a fax

To send a fax using Quick Dial: 

1. Press Phonebook. 

2. Press the number on the keypad that corresponds to the desired Quick Dial 
entry. 

3. Press Start Black to send a black-and-white fax or Start Color to send a 
color fax. 

Using the numeric keypad to send a fax

To send a fax using the numeric keypad:

1. Press Fax.

2. Enter a fax number using the numeric keypad.

3. Press Start Black to send a black-and-white fax or Start Color to send a 
color fax.
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Using the Redial button to send a fax
To send a fax to one of the last numbers dialed: 

1. Press Redial.
2. Press  to select an entry. 

3. Press Start Black to send a black-and-white fax or Start Color to send a 
color fax.

If there is no number to redial, the phonebook opens.

Receiving a fax
You can set up your printer to receive faxes automatically or manually. Even if your 
printer is set up to receive faxes automatically, you can still receive them manually at 
any time. 

Receiving a fax automatically

To receive faxes automatically: 

1. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain 
paper into the paper tray (see Loading plain paper, page 38). 

2. Make sure the Auto Answer LED is on. (If not, press Auto Answer on the control 
panel to turn it on.) 

The printer will receive all incoming faxes automatically.

IMPORTANT: Whenever there is an incoming fax, the printer LCD shows the message, 
“Incoming Call. Press START to Answer.” If the Auto Answer LED is on, you 
do not need to press START to receive the fax. The printer will automatically 
receive the fax after the number of rings that you selected for the fax 
settings (see Rings to Answer under Selecting fax settings, page 83). 
However, you may choose to receive the fax sooner by pressing either START 
button. (Whether the fax is color or black-and-white is determined by the 
sender.) 
92 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Receiving a fax manually 
If Auto Answer is turned off for your printer, you can receive incoming faxes 
manually. You can receive any incoming fax manually, even if Auto Answer is 
turned on.

To receive a fax manually: 

• When you hear the phone ring, press Start Black or Start Color.

NOTE: Pressing either Start button prompts the printer to receive the fax. It 
does not matter which Start button you press; whether a fax is color or 
black-and-white is determined by the sender. 

If your printer is connected to the same phone line as another telephone and you are 
using tone dialing (see Dialing Mode under Selecting fax settings, page 83), you may 
receive an incoming fax manually from another phone. When you hear the 
distinctive ring of your fax line or know that the incoming call is a fax: 

• Pick up any phone and dial 234 (the remote access code). 

Printing fax reports
You can set up the printer to print certain reports automatically. You can also print 
reports manually at any time. 

Fax settings report

To print the current fax settings: 

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  to select Print Fax Settings, then press OK.

4. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain 
paper, then press Start Black or Start Color. 
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Fax confirmation page
The Fax Confirmation Page contains the time and date of transmission, the number 
that you called and the number you called from, and whether the transmission was 
successful. To print the Fax Confirmation Page, you must select the option to print it 
before you transmit the fax. The default setting is to never print the Fax Confirmation 
Page. 

To print the fax confirmation page for future faxes: 

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  to select Print Fax Conf. Page.

4. Press or  to select Always (to print a confirmation page after sending every 
fax) or After Fail Only to print only if the fax transmission fails. 

5. Press OK.

NOTE: The name and fax number of receivers will not appear on your confirmation 
page if the receivers have not set up that information on their fax machines. 

Fax activity log

The Fax Activity Log provides detailed information for approximately the last 30 
faxes sent or received. The log contains information such as date, time, duration of 
transmission, to/from, and number of pages. 

To print a Fax Activity Log:

1. Press Home.

2. Press  to select Fax Settings, then press OK. 

3. Press  to select Print Fax Activity Log, then press OK.

4. Load letter (8.5 x 11 in. / 22 x 28 cm) or A4 (8.3 x 11.7 in. / 21 x 30 cm) plain 
paper, then press Start Black or Start Color. 

NOTE: The name and fax number of receivers will not appear on your Fax Activity 
Log if the receivers have not set up that information on their fax machines. 

Canceling a fax
You can cancel a fax that you are sending or receiving at any time. 

To cancel sending or receiving a fax, press Cancel. 
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Your printer requires little maintenance. However, Kodak recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the 
quality and accuracy of scanning and copying.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. 
If you use a power strip, don't turn off the power strip. (The printer does not need to 
be turned on but should be plugged in.)

Keep the printhead and ink cartridges in the printer at all times to help prevent 
damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, 
go to the Electronics Industry Alliance at www.eia.org or go to 
www.kodak.com/go/recycle. 

General care and cleaning
CAUTION:

Always disconnect the power to the printer before cleaning it. Do not use 
harsh or abrasive cleaners on any part of the printer.

• To clean the printer, wipe the outside with a clean, dry cloth.

• Keep the surrounding area vacuumed and litter-free. 

• Protect the printer from tobacco smoke, dust, and liquid spills. 

• Do not place objects on the printer. 

• Keep the paper input tray free of dust, dirt, and other foreign objects. 

• Keep the printer supplies away from direct sunlight and out of high-temperature 
environments.

• Do not allow chemicals to come into contact with the printer. 
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Cleaning the scanner glass and document backing
The scanner glass can get smudged and minor debris can accumulate on the white 
document backing under the scanner lid. Periodically clean the scanner glass and 
document backing. 

CAUTION:
Do not use harsh or abrasive cleaners on any part of the printer. 
Do not spray liquid directly on the glass.
Do not use paper-based wipes on the document backing as they can 
scratch it.

To clean the scanner glass and document backing under the scanner lid: 

1. Turn off the printer and unplug it from the power outlet. 

2. Lift the scanner lid. 

3. Wipe the glass with a soft cloth or sponge, slightly moistened with a 
nonabrasive glass cleaner. 

document backing

scanner glass
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4. Dry the glass with a lint-free cloth.

5. Gently clean the document backing with a soft cloth or sponge, slightly 
moistened with mild soap and warm water. 

6. Dry the document backing with a chamois or soft, lint-free cloth.

NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) 
alcohol on a soft cloth, then wipe thoroughly with a cloth moistened with 
water to remove any residual alcohol. 

7. When you finish cleaning, plug in the printer.
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Replacing ink cartridges
Your printer uses black and color ink cartridges. You can check the approximate ink 
levels on the LCD (see Checking ink levels, page 107) or in Home Center Software. 
When an ink cartridge is out of ink, the printer LCD displays a message stating that 
the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

To replace an ink cartridge: 

1. Make sure your printer is on.

2. Lift the access door, and wait for the carriage to move to the access position. 

The ink cartridges are located in the printhead. 

black 
ink cartridge

color ink cartridge

printhead 
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3. Pinch the tab on the ink cartridge. 

4. Lift the ink cartridge out of the printhead. 

5. Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the 
printhead immediately.
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6. Remove the cap.

7. Insert the ink cartridge into the printhead.

8. Press down on the ink cartridge tab until you hear a click.

9. Close the access door. 
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Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Kodak.

To replace the printhead:

1. Make sure the printer is on.

2. Lift the access door, and wait for the carriage to move to the access position.

3. Remove both ink cartridges and set them aside. 
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4. Unlatch the existing printhead by lifting the button.

5. Lift the used printhead out of the carriage.

6. Remove the new printhead from its bag.

CAUTION:
Do not touch the copper contacts on the printhead, as doing so may damage 
the printhead.
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7. Remove the plastic protective cap.

8. Install the new printhead in the carriage.

9. Push firmly against the target label of the printhead until you hear a click.

Copper contacts
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10. Insert the black ink cartridge into the printhead. 

11. Press down on the ink cartridge until you hear a click.

12. Repeat steps 10 - 11 for the color ink cartridge. 

13. Close the access door. 

The printer detects the new printhead. Follow the instructions on the LCD to 
calibrate your printer. 
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Updating the software and printer firmware
Using the latest software and firmware helps ensure optimal performance of your 
printer. 

NOTE: Firmware is the software that runs on the printer.

Although there is a an automatic check for software and firmware updates when 
your computer is connected to the Internet, you can update manually using the 
following procedure. 

Updating if your printer is connected to a computer with WINDOWS OS

To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software, then select Printer Tools.

NOTE: If you do not have Home Center Software, select Start > All Programs > 
Kodak > KODAK AiO Printer Tools. 

3. Under Printer Resources, click Check for Software Updates to check whether 
software updates are available.

4. If there are updates, click Next and follow the on-screen instructions. 

To update the printer firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable or wirelessly (if not 
currently connected). 

3. Open Home Center Software, then select Printer Tools.

NOTE: If you do not have Home Center Software, select Start > All Programs > 
Kodak > KODAK AiO Printer Tools. 

4. Make sure that KodakESP2150+xxxx - Connected (or a similar name with 
Connected) appears in the lower left corner of the Printer Tools window.

NOTE: If KodakESP2150+xxxx - Connected does not appear in the lower left 
corner, click Select, then click Refresh List and choose your printer from 
the list; click OK and follow the on-screen instructions. 

5. Under Printer Resources, click Check for Printer (Firmware) Updates.

6. If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 
Doing so may cause the printer to become inoperable. If the printer is 
connected wirelessly, make sure you have a stable connection when you 
perform the update. During the upgrade, your printer will restart. Wait for 
the message, “Update complete! You may now use your Kodak Printer” to 
appear on your computer. 
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Updating if your printer is connected to a computer with MAC OS
To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software.

3. Select the Tools tab.

4. Click Check for Software Updates.

5. If there are software updates, follow the on-screen instructions.

To update the firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable or wirelessly (if not 
currently connected). 

3. Open Home Center Software. 

4. Select the Tools tab.

5. Click Check for Printer (Firmware) Updates.

6. If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 
Doing so may cause the printer to become inoperable. Your printer will 
restart during the update. 
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Monitoring and adjusting printer performance
From the control panel, you can perform tasks to help keep the printer 
functioning well.

Checking ink levels

To check the ink levels: 

1. Press Home.

2. Press  to select Maintenance, then press OK.

3. With Check Ink Levels selected, press OK.

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges. Use 30 Series ink cartridges.

NOTE: You can order ink cartridges online. Open Home Center Software and select 
Order Supplies or go to www.kodak.com/go/printingsupplies.

Resetting factory defaults

To reset defaults to the factory default settings: 

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select Reset All Settings, then press OK. 

4. When you see the message, “This will reset printer settings to factory defaults,” 
press OK.

NOTE: Resetting factory defaults does not change the date and time, language, or 
country/region.
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11 Troubleshooting

Basic troubleshooting
If you experience an error with your printer, restarting your printer will sometimes fix 
the problem. Turn off your printer, wait five seconds, then turn on your printer. 

If you still experience a problem, use the following information to help troubleshoot 
your printer.

Problem Possible Solutions

Printer does not 
power on

• Make sure you are using the power cord that came with your printer. 
• Make sure that the power cord is connected to the AC adapter and is plugged into 

an outlet or power strip, and that the LED on the AC adapter is lit.
• Make sure that the power cord is securely connected to the power cord port in the 

back of the printer.

Printer not detected • Make sure that your printer is plugged in and turned on.
• If you are using a USB cable, make sure that: 

– it is a USB 2.0 high-speed cable.
– it is connected to both your printer and your computer.
– you restart the computer if the USB cable was disconnected from the printer 

then reconnected, or if power to the printer was interrupted.
• If you are using a wireless connection, make sure:

– the Wi-Fi connectivity LED remains lit.
– the printer is connected to your wireless network.

To check:
a. On the printer, press Home.
b. Press  to select Network Settings, then press OK.
c. Press  to select View Network Configuration, then press OK. 

Make sure that the Active Connection Type is Wi-Fi, and that the IP Address 
is not all zeros. 

– your router is transmitting data.
– the firewall (excluding WINDOWS Firewall) is allowing the services needed for 

your printer.

For additional information, go to www.kodak.com/go/inkjetnetworking.

Wireless connectivity For wireless connectivity issues, go to www.kodak.com/go/inkjetnetworking.

Carriage jam • Open the access door and clear any obstructions.
• Make sure that the printhead and ink cartridges are installed correctly. 

(The printhead and ink cartridges are installed correctly when you hear them click 
into place.)

Ink cartridge errors • Make sure that KODAK Ink Cartridges are installed. Do not use non-Kodak brand or 
refilled ink cartridges. 

• Remove, then install the cartridges again. Make sure the cartridges click into place.
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Too much paper curl 
after printing

• If you are printing pictures or documents with large areas of image content, try 
increasing the top and bottom margins when printing in portrait mode or the left 
and right margins when printing in landscape mode. Start with a 1.0-inch (2.5-cm) 
margin on top and bottom and a 0.25-inch (0.62-cm) margin on the sides. The 
larger the margin, the less potential there is for curl.

• Print on a higher weight paper, such as 24 lb (90 gsm) paper or print on KODAK 
Ultimate Paper.

• Apply a border, rather than printing in borderless mode.
• If the paper is not stacking properly in the output tray, remove the pages as they 

exit.

Print quality • For best results, use KODAK Paper or a paper with the COLORLOK Technology logo 
on the package.

• Make sure the paper is loaded correctly. See Loading plain paper, page 38 and 
Loading photo paper, page 39.

• Clean the printhead:

– Press Home.
– Press  to select Maintenance, then press OK.
– Press  to select Clean Printhead, then press OK.

• Calibrate the printer:

– Press Home.
– Press  to select Maintenance, then press OK.
– Press  to select Calibrate Printer, then press OK.

For more information, go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type the problem in the search field.

Paper jam • Open the access door and gently pull paper out from the front, reaching through the 
opening above the paper output tray.

• If you cannot access the paper from the front, gently pull the jammed paper up from 
the paper input tray.

• Make sure the paper in the input tray is free of tears or creases.
• Make sure you do not overload the paper input tray.
For more information, go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type jam in the search field.

Problem Possible Solutions
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Getting help on the Web
For more troubleshooting information:

Cannot send or 
receive a fax

• Make sure that the wall phone line is plugged into the Line in port. 
• Verify that the wall jack works by plugging in a phone and checking for a dial tone.
• Verify that Region is set to the correct country code. 

– Press Home.
– Press  or  to select Printer Settings, then press OK.
– Press  to select Country/Region, then press OK.
– Press  or  to select your country, then press OK.

• If you are connected to a DSL phone line, make sure you have a DSL filter connected 
to the phone jack. 

For more information, go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type Fax in the search field. 

Error codes/messages 
or other problems you 
cannot resolve

• Go to www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support, then type your error code or message.

If you need to contact Kodak (see www.kodak.com/go/contact), have the following 
information available: 

• KODAK Service Number (located inside the printer when you open the access door)
• Printer model number (located on the control panel) 
• Computer model, operating system, and version of Home Center Software 
• Exact wording of any error message(s) and the error code

Problem Possible Solutions

Get help with wireless networking. www.kodak.com/go/inkjetnetworking

Search our knowledge base of Questions and 
Answers.

www.kodak.com/go/esp2150support or 
www.kodak.com/go/esp2170support

Download the latest firmware and software for 
optimal printer performance.

www.kodak.com/go/esp2150downloads or 
www.kodak.com/go/esp2170downloads

Check the Extended User Guide for detailed 
instructions and the recommended system 
requirements

www.kodak.com/go/aiomanuals
www.kodak.com/go/esp2150manuals 
www.kodak.com/go/esp2170manuals
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Get help with problems you cannot resolve. Contact Kodak at www.kodak.com/go/contact and have the 
following information available: 
– KODAK Service Number (located inside the printer when 

you open the printer access door)
– Printer model number (located on the control panel above 

the LCD)
– Computer model, operating system, and version of Home 

Center Software
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Status lights
There are three status lights on the printer: the power status light (on the on/off 
button) indicates power, the Wi-Fi status light indicates Wi-Fi status, and the 
attention light blinks when an error occurs.

Power light

Wi-Fi connectivity LED 

Power light What it means

Off • The printer is turned off.

– Press the power button to turn on power.

• The printer does not have power.

– Make sure that the power cord is plugged into the 
back of the printer and into an electrical outlet, and 
that the electrical outlet has power.

Blinking • The printer is busy.

– Wait for the printer to finish the task.

On The printer is ready.

Wi-Fi connectivity LED What it means

Off The Wi-Fi radio is either turned off or is turned on but not 
connected to a wireless network.

Blinks continuously The Wi-Fi radio is turned on, and the printer is searching for 
available wireless networks within range.

Blinks intermittently The Wi-Fi radio is turned on and the printer cannot find any 
available wireless networks within range, or the Wi-Fi radio 
connection has been interrupted, or is too weak to send 
signals to and from the printer.

To find and connect to an available wireless network within 
range, press OK, turn the Wi-Fi radio off, and run the Wi-Fi 
Setup Wizard (see Connecting to a wireless network, 
page 6).

On The Wi-Fi radio is turned on, and there is a working 
connection between the printer and a wireless network.
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12 Product and Safety Specifications
The following specifications are subject to change without notice.

Features and Specifications

Print performance

Photo printing features

Black print speed 6 images per minute 

Color print speed 4 images per minute 

Print technology Continuous-tone, thermal inkjet

Print quality modes Draft, Normal, and Best on plain paper

Photo quality mode on photo paper

Quantity 1 to 99 

Print sizes 2 x 3 in. / 5 x 8 cm
3.5 x 5 in. / 9 x 13 cm
4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 30 cm (Panoramic) 

5 x 7 in. / 13 x 18 cm
8 x 10 in. / 20 x 25 cm
US Letter - 8.5 x 11 in. / 22 x 28 cm
A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Best, Normal, Draft modes on plain paper

Photo quality mode on photo paper 

Auto-detect media Auto-detect plain paper and photo papers

Optimize image quality for KODAK Photo Papers with barcode

Image enhancement KODAK PERFECT TOUCH Technology with 
Home Center Software (from the computer only)

Color Black-and-white or color

Scene balance On (default), Off 
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Copy document features

Copy photo features

Scanning features

Color Black-and-white or color

Quantity 1 to 99 copies 

Copy sizes Same Size, Fit to Page, 20% to 500% 

Plain paper quality Best, Normal, Draft

Brightness – 3 to + 3

Color Black-and-white or color

Quantity 1 to 99 

Copy sizes 2 x 3 in. / 5 x 8 cm
3.5 x 5 in. / 9 x 13 cm
4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 30 cm (Panoramic) 

5 x 7 in. / 13 x 18 cm
8 x 10 in. / 20 x 25 cm
US Letter - 8.5 x 11 in. / 22 x 28 cm
A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Automatic

Brightness – 3 to + 3

Scanner type Contact Image Sensor (CIS)

Scan sizes Maximum size of original scanned from platen: 
8.5in. / 22 cm wide; 11.7 in. / 30 cm long 

Sizes of originals scanned from ADF:

B5 (6.9 x 9.8 in. / 18 x 25 cm)
US Executive (7.3 x 10.5 in. / 18 x 27 cm)
US Letter (8.5 x 11 in. / 22 x 28 cm)
A4 (8.3 x 11.7 in. / 21 x 30 cm)
US Legal (8.5 x 14 in. / 22 x 36 cm) 

Functions Segmentation scanning

Auto-destination

Optical Character Recognition (OCR) 
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KODAK ESP Office 2100 Series All-in-One Printer
Faxing features and specifications

Input paper tray 

Output paper tray 

Automatic Document Feeder (ADF) for originals

Ink cartridges

Connectivity

Fax transfer rate 9600, 14400, or 33600 (default) baud 

Fax memory 100 pages at 96 dpi text

Speed dials Up to 60

Resolution Standard: 200 x 100
Fine: 200 x 200
Photo: 300 x 300

Paper capacity 150 sheets of 20 lb plain paper

20 sheets of photo paper, up to 12 mil (290 gsm)

20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm 

Paper capacity 50 sheets of 20 lb plain paper

20 sheets of photo paper, up to 12 mil (290 gsm)

20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm 

Paper capacity 25 sheets (20 to 24 lb / 75 to 90 gsm) plain paper

Paper size limits 6.9 x 9.8 in. to 8.5 x 14 in. / 18 x 25 cm to 22 x 36 cm

Ink handling 2-cartridge, 4-ink system

Ink life 1-year warranty from date of purchase

Protocols supported USB 2.0 High Speed; DPOF

Devices supported WINDOWS OS-based and MACINTOSH Computers, memory 
cards (SD, MS/Duo, MMC, SDHC)

Image formats supported Image printing supports JPEG (EXIF v2.21 non-progressive); 
does not support progressive JPEG format; image scanning 
supports scanning to JPG and non-searchable PDF

Number of USB ports One USB 2.0 high-speed port device port on the back for 
connecting the printer to the computer (as needed), one USB 
2.0 high-speed port host port in the front for connecting USB 
devices front (ESP Office 2170 only)
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Product and Safety Specifications
Software support

Physical specifications

Warranty

Wi-Fi technology
supported

802.11b/g/n, WPA/WPA2, WPS, and WEP

Application support Third-party image-management software; optical character 
reader (OCR) support for documents

Media support Plain paper, photo paper, envelopes, greeting cards, card stock, 
and labels

Scanner support TWAIN and WIA, WIA2 (WINDOWS 7 and VISTA OS), ICA 
(MAC OS) and TWAIN (on MAC OS 10.4 and 10.5), including 
segmentation scanning

Update support Software and firmware updates available through Web support

Power Input: 110–240 V AC, 50–60 Hz 
Output: 36 V DC at 1.6 A

Storage dimensions 45.5 cm (17.9 in.) wide x 41.5 cm (16.3 in.) deep x 23.0 cm
(9.1 in.) tall with input and output trays closed

Operating dimensions 45.5 cm (17.9 in.) wide x 65.0 cm (25.6 in.) deep x 29.6 cm
(11.7 in.) tall with input and output trays fully extended for
operation

Weight 6.9 kg (15.2 lb) without power supply, printhead, or ink
cartridges

Operating range 5°C (41°F) to 35°C (95°F), 15 to 85% RH

Full image quality
environmental range

15°C (59°F) to 30°C (86°F), and 20 to 80% RH

Energy efficiency ENERGY STAR® Qualified 

Product One year from purchase (with proof of purchase)

Printhead One year from purchase (with proof of purchase)
116 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Minimum System requirements

Computer with WINDOWS OS

Computer with MAC OS

Computer Minimum

Operating System WINDOWS 7, VISTA, or XP (SP2 or later)

CPU INTEL CELERON Processor

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 500 MB available

Interface USB 2.0 cable 

CD drive CD-ROM

Computer Minimum

Operating System MACINTOSH OS X 10.4.8 or later

CPU PowerPC G4, G5, or INTEL-based MAC

Clock speed 1.2 GHz

Memory 512 MB RAM 

Available hard disk space 200 MB available

Interface USB 2.0 cable

CD drive CD-ROM
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Product and Safety Specifications
Paper types supported

Paper sizes supported

Plain paper 16 to 24 lb (60 to 90 gsm)

Photo paper 6.5 to 12 mil 

Card stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Transparencies All commercially available inkjet varieties (with a white strip 
on the long edge) - 8.5 x 11 in. and A4 size

Labels All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Iron-on transfers All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Plain paper A4 (8.3 x 11.7 in. / 21 x 30 cm)

A5 (5.8 x 8.3 in. / 15 x 21 cm)

A6 (4.1 x 5.8 in. / 11 x 15 cm)

B5 (6.9 x 9.8 in. / 18 x 25 cm)

US Executive (7.3 x 10.5 in. / 18 x 27 cm) 

US Letter (8.5 x 11 in. / 22 x 28 cm)

US Legal (8.5 x 14 in. / 22 x 36 cm)

Custom sizes from 4–8.5 in. / 10–22 cm wide and 6–14 in. / 
15–36 cm long

Labels A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Index card stock 4 x 6 in. index cards (10 x 15 cm)

5 x 7 in. index cards (13 x 18 cm)

Iron-on transfers A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in.) (22 x 28 cm)

Envelopes C5 (6.4 x 9 in. / 16 x 23 cm)

C6 (4.5 x 6.4 in. / 11 x 16 cm)

DL (designated long) (4.3 x 8.7 in. / 11 x 22 cm)

US #10 (4.1 x 9.5 in / 11 x 24 cm)

US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

US #9 (3.9 x 8.9 in. / 10 x 23 cm)
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KODAK ESP Office 2100 Series All-in-One Printer
Photos 4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 31 cm

5 x 7 in. / 13 x 18 cm

7 x 10 in. / 18 x 25 cm

8 x 10 in. / 20 x 25 cm

US Letter (8.5 x 11 in. / 22 x 28 cm)

A4 (8.3 x 11.7 in. / 21 x 30 cm)
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Product and Safety Specifications
Safety information
KODAK ESP Office 2100 Series All-in-One Printers are Class 1 LED Products.

• Always follow all warnings and instructions marked on the product.

• Use only a Hipro HP-A0601R3 or Flextronics VP-09500084-000 certified 
external power supply (provided with the product).

• Use only the power cord that comes with the product (or an approved power 
cord greater than or equal to H05W-F, 3G, 0.75 mm2). Using another power 
cord may cause fire and/or shock. Do not use the included power cord with any 
other equipment. 

• Always turn this product off by using the On/Off button. Wait until the On/Off 
button stops flashing before removing the power plug from the outlet. 

• Do not allow the power cord to become damaged or frayed.

• If you need to use an extension cord with this product, make sure that the 
ampere rating of the product does not exceed the ampere rating of the extension 
cord.

• Place the product on a flat, stable surface that extends beyond the product’s 
base in all directions. This product will not operate properly if tilted or at an 
angle.

• When storing or transporting this product, do not tilt or stand it on its side. 
Never turn this product upside down (ink can leak out of the product).

• Avoid placing this product in an environment that is subject to rapid changes in 
temperature or humidity, mechanical shocks, vibration, or dust. Do not place 
near radiators, heating vents, or in direct sunlight.

• Leave enough room around this product for sufficient ventilation. 

• Do not block this product’s covers or openings, or insert any objects through 
slots. 

• Do not use aerosol products inside or around this product.

• Do not spill any liquid on this product.

• Do not attempt to repair or service this product.

• If the power cord or plug is damaged, if any liquid has been spilled onto the 
product, if the product has been dropped or the case damaged, if the product 
does not operate normally or exhibits a major change in performance level, 
unplug this product and contact Kodak at www.kodak.com/go/contact.

For Service Personnel:

CAUTION:
Risk of explosion if battery is replaced by an incorrect type. Dispose of used 
batteries according to local instructions.
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KODAK ESP Office 2100 Series All-in-One Printer
LCD screen safety

• Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or 
chemical cleaners.

• If the LCD screen is damaged, contact Kodak immediately. If any of the solution 
from the display gets on your hands, wash them thoroughly with soap and water. 

Ink cartridge safety

• Keep all ink cartridges out of the reach of children.

• If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 
immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.

• For MSDS information on inks, go to www.kodak.com/go/MSDS.

NOTE: You will need the catalog number from the ink package.
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Product and Safety Specifications
Regulatory compliance

FCC statement

The United States Federal Communications Commission (in CFR 47 Part 15.105) has 
specified that the following notice be brought to the attention of the users of this 
product:

NOTE: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver

• Connect the product into an outlet on a circuit different from that to which 
the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this 
product not expressly approved by Eastman Kodak Company might cause 
harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency 
exposure limits. Nevertheless, the product shall be used in such a manner 
that the potential for human contact during normal operation is minimized. 
This product and any attached external antenna, if supported, shall be placed 
in such a manner to minimize the potential for human contact during normal 
operation. In order to avoid the possibility of exceeding the FCC exposure 
limits, human proximity shall not be less than 20 cm (8 inches) during normal 
operation.
122 www.kodak.com/go/aiosupport



KODAK ESP Office 2100 Series All-in-One Printer
Canadian statements
This product meets the applicable Industry Canada technical specifications.

Operation is subject to the following two conditions: (1) this device may not cause 
interference, and (2) this device must accept any interference, including interference 
that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with a 
minimum distance of 20 cm between the radiator and your person.

European compliance statement

Hereby, Eastman Kodak Company declares that this KODAK all-in-one wireless 
printer is in compliance with the essential requirements and other relevant 
provisions of Directive 1999/5/EC.

German compliance statement 

CAUTION:
This device is not intended for use in the direct field of view at visual display 
workplaces. To avoid incommoding reflections at visual display workplaces 
this device must not be placed in the direct field of view.

CAUTION:
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am 
Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am 
Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im 
unmittelbaren Gesichtsfeld platziert verden.

Noise emissions for this equipment do not exceed 70 dB(A).

This equipment is not intended for use in the work place in accordance with 
BildscharbV regulations.

Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß BildscharbV 
vorgesehen. 
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Product and Safety Specifications
REACH Article 33 declarations
Go to www.kodak.com/go/REACH for information about the presence of 
substances included on the candidate list according to article 59(1) of Regulation 
(EC) No. 1907/2006 (REACH).

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. 
Contact your local authorities or go to www.kodak.com/go/recycle for recycling 
program information.

ENERGY STAR® Qualified
To conserve energy, this printer will enter a reduced power (sleep) mode 
automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up 
to 4 hours. Increasing the delay time may result in reduced energy savings.

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an 
ENERGY STAR partner, Kodak has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency. For more information on the ENERGY STAR 
program, see www.energystar.gov. 

 

VORSICHT:VORSICHT:
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KODAK ESP Office 2100 Series All-in-One Printer
Warranty Information
Limited Warranty

Kodak warrants Kodak consumer electronic products and accessories (“Products”), 
excluding batteries, to be free from malfunctions and defects in both materials and 
workmanship for one year from the date of purchase. Retain the original dated sales 
receipt. Proof of the date of purchase will be required with any request for warranty 
repair.

Limited Warranty Coverage

Warranty service is only available from within the country where the Products were 
originally purchased. You may be required to send Products, at your expense, to the 
authorized service facility for the country where the Products were purchased. 
Kodak will repair or replace Products if they fail to function properly during the 
warranty period, subject to any conditions and/or limitations stated herein. 
Warranty service will include all labor as well as any necessary adjustments and/or 
replacement parts. If Kodak is unable to repair or replace a Product, Kodak will, at its 
option, refund the purchase price paid for the Product provided the Product has been 
returned to Kodak together with proof of the purchase price paid. Repair, 
replacement, or refund of the purchase price are the sole remedies under this 
warranty. If replacement parts are used in making repairs, those parts may be 
remanufactured or may contain remanufactured materials. If it is necessary to 
replace the entire Product, it may be replaced with a remanufactured Product. 
Remanufactured Products, parts and materials are warranted for the remaining 
warranty term of the original Product, or 90 days after the date of repair or 
replacement, whichever is longer.

Limitations

This warranty does not cover circumstances beyond Kodak’s control. This warranty 
does not apply when failure is due to shipping damage, accident, alteration, 
modification, unauthorized service, misuse, abuse, use with incompatible 
accessories or attachments (such as third party ink or ink tanks), failure to follow 
Kodak’s operation, maintenance or repacking instructions, failure to use items 
supplied by Kodak (such as adapters and cables), or claims made after the duration 
of this warranty. KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY 
FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. In the event that the exclusion of any implied warranty is ineffective 
under the law, the duration of the implied warranty will be one year from the 
purchase date or such longer period as required by law. The option of repair, 
replacement, or refund is Kodak’s only obligation. Kodak will not be responsible for 
any special, consequential or incidental damages resulting from the sale, purchase, 
or use of this product regardless of the cause. Liability for any special consequential 
or incidental damages (including but not limited to loss of revenue or profit, 
downtime costs, loss of the use of the equipment, cost of substitute equipment, 
facilities or services or claims of your customers for such damages resulting from 
the purchase, use or failure of the Product), regardless of cause, or for breach of any 
written or implied warranty is expressly disclaimed.
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Product and Safety Specifications
Your Rights

Some states or jurisdictions do not allow exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 
Some states or jurisdictions do not allow limitations on how long an implied 
warranty lasts, so the above limitation may not apply to you. This warranty gives you 
specific rights, and you may have other rights which vary from state to state or by 
jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada

In countries other than the United States and Canada, the terms and conditions of 
this warranty may be different. Unless a specific Kodak warranty is communicated to 
the purchaser in writing by a Kodak company, no warranty or liability exists beyond 
any minimum requirements imposed by law, even though defect, damage, or loss 
may be by negligence or other act.

Declaration of Conformity
See www.kodak.com/go/declarationofconformity. 
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Index

A
access door, location, 1
ADF (automatic document feeder)

capacity, 115
loading, 42, 58
location, 1

ADF paper-edge guides, location, 1
ANDROID OS Device, printing from, 57
Apple Macintosh see MAC OS computer
attention light, location and function, 2
auto answer button, location and function, 2
auto answer LED, location and function, 2
auto answer, setting for faxing, 86

B
back button, location and function, 2
black-and-white

copying, 59, 64
fax, sending, 91
printing photos, 48, 50, 51, 52
scanning, 71, 72, 73, 74

BLACKBERRY Device, printing from, 56

C
call waiting, disabling, 84
cancel button, location and function, 2
card slot, location, 1
cleaning

document backing, 96
printer, 95
scanner glass, 96

color
copying, 59, 64
fax, sending, 91
scanning, 71, 72, 73, 74

components, 1
computer requirements, 117
configuring printer settings, 5
connecting to a wireless network, 6—12

additional printer, 12
from USB, 13
printer on additional computers, 12

control panel, location, 1
copy mode button, location and function, 2

copying, 58—66
documents, 58—60

adjusting settings, 59
black-and-white, 59
brightness, 59, 60
color, 59
copy sizes, 114
darkening, 59, 60
enlarging, 59, 60
features, 114
fit to page, 59
lightening, 59, 60
number of copies, 59, 60
quality, 59
quantity, 59, 60
reducing, 59, 60
two-sided, 61
using default settings, 58

loading originals, 58
photos, 62—66

adjusting settings, 63—64
black-and-white, 64
brightness, 64, 66
color, 64
copy sizes, 114
darkening, 64, 66
enlarging, 63, 65
features, 114
lightening, 64, 66
number of copies, 63, 64
previewing on LCD, 64
quality, 63
quantity, 63, 64
reducing, 63, 65
sizes, 63
using default settings, 62

two-sided, 61
country/region, setting, 5
cover page, fax, 89

D
darkening copies

documents, 59, 60
photos, 64, 66
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Index
date and time, setting, 5
declaration of conformity, 126
defaults

resetting, 5, 107
save copy settings as

documents, 59
photos, 64

save photo printing settings as, 50
save scan settings as, 71, 72

distinctive ring, 84
document backing, cleaning, 96
documents

paper sizes, 118
printing, 43—44
printing two-sided, 43—44

downloading (updating)
printer firmware, 105—106
software, 105—106

DPOF (digital print order format), printing, 5, 51
duplexing, 43—44, 61

E
ENERGY STAR qualification, 124
energy-saving sleep mode, 5
enlarging copies

documents, 59, 60
photos, 63, 65

envelopes
capacity, 40
loading, 40
sizes, 36, 118

F
fax mode button, location and function, 2
fax settings

configuring with Online Printer Management 
Tool, 18—20

faxing, 78—93
activity log, 85
answering machine setup, 81
answering service setup, 82
brightness and resolution, 90
call waiting

disable code, 84
disabling, 84

confirmation page, 85
cover page, 85, 89
darkening, 90
dedicated phone line setup, 81
dialing mode

pulse, 85
tone, 85

distinctive ring, 84
error correction mode, 86
header information, entering, 82
lightening, 90
loading originals, 89
phonebook, 86

adding entries, 87
deleting entries, 88
editing entries, 88

preparing transmission, 89
printing fax settings, 85
receiving, 92—93

automatically, 92
manually, 93

resolution and brightness, 90
rings to answer, 83
sender information, entering, 82
sending, 91—92

using numeric keypad, 91
using phonebook, 91
using quick dial, 91
using redial button, 92

setting answer mode, 86
setting options, 83—86
setting options with Online Printer Management 

Tool, 18—20
setting up, 78
shared phone line setup, 81

finding photos, 49
on memory card, 46
on USB-connected device, 46

firmware, downloading (updating), 105—106

G
glass, scanner

cleaning, 96
location, 1

Google Cloud Printing, 54
setting up, 30—31

graph paper, printing, 45
grocery list, printing, 45

H
home button, location and function, 2
Home Center Software, 3, 69, 75, 106
hostname, printer, 11
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Index
I
Image Capture software, 53
image formats supported, 115
index card stock, sizes, 118
ink cartridges, replacing, 98—100
ink levels, 107
IP Address

setting up, 10
viewing, 11

iPad, printing from, 56
iPhone, printing from, 56
iPhoto software, 53
iPod touch device, printing from, 56
iron-on transfers, sizes, 35, 118

K
keyboard on LCD, using, 7, 87, 88
KODAK All-in-One Printer Software, 3
KODAK Email Print Service

printing from, 55
setting up, 31

KODAK Home Center Software
see Home Center Software

L
label sizes, 118
language, setting, 5
LCD screen, location and function, 2
lightening copies

documents, 59, 60
photos, 64, 66

loading originals
for copying, 58
for faxing, 89
for scanning, 70
on scanner glass, 41
using ADF, 42, 58

loading paper input tray
envelopes, 40
photo paper, 39
plain paper, 38

low power, setting, 5

M
MAC address, viewing, 11
MAC OS 

computer, 3, 4, 8, 9, 12, 13, 15, 26, 44, 45, 53,
67, 68, 69, 75, 76, 106, 116, 117

media supported, 118
memory card slot, location, 1
memory cards, printing from, 47

N
narrow-ruled paper, printing, 45
navigation buttons, location and function, 2
network, wireless

See wireless network
numeric keypad on control panel

location and function, 2
using to enter text and numbers, 88

O
OK button, location and function, 2
Online Printer Management Tool, 14—34

accessing, 15
changing printer name with, 17
configuring fax settings with, 18—20
configuring printer settings with, 16

originals, loading
for copying, 58
for faxing, 89
for scanning, 70
on scanner glass, 41
using ADF, 42, 58

output tray extender, location, 1

P
panoramic photos, printing, 52
paper, 35—42

loading input tray
envelopes, 40
photo paper, 39
plain paper, 38

sizes supported, 36, 118
types supported, 35, 118

paper input tray
capacity, 115

envelopes, 40
photo paper, 39
plain paper, 38

location, 1
paper output tray, location, 1
paper-edge guides, location, 1
phone port, location, 1
phonebook

adding new entries, 87
deleting entries, 88
editing entries, 88

phonebook button, location and function, 2
photo mode button, location and function, 2
photo paper

capacity, 39
loading, 39
sizes, 119
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Index
photos
finding on memory card, 46
finding on USB-connected device, 46
print sizes, 113
printing, 45—52

DPOF, 51
quality, 113
scene balance, 113
tagged, 51

transferring to computer, 53
viewing, 46

pictures see photos
PIN, setting, 23, 28
plain paper

capacity, 38
loading, 38

ports
phone line for faxing, 1
USB, 1

power button, location and function, 2
power cord connection port, location, 1
printer

changing name, 17
cleaning instructions, 95
defaults, resetting, 5, 107
hostname, 11
maintaining, 95—104
settings, configuring, 5

with Online Printer Management Tool, 16
supplies

ordering, 4
recycling, 95

printer connection, changing USB to wireless, 13
printhead

removing, 102
replacing, 101—104

printhead, location, 1
printing, 43—56

documents, 43—44
two-sided, 43—44

forms, 45
from ANDROID OS Device, 57
from BLACKBERRY Device, 56
from iPad, 56
from iPhone, 56
from iPod touch device, 56
from mobile devices, 54—56

photos, 45—52
DPOF, 51
from memory card, 47
from USB-connected device, 47
image enhancement, 113
panoramic, 52
tagged, 51
tagged images, 5

speed, 113
two-sided documents, 43—44
using Google Cloud Print, 54
using KODAK Email Print Service, 55

Q
quick dial, 87

R
receiving fax, 92—93

automatically, 92
manually, 93

recycling printer or supplies, 95
redial button, location and function, 2
reducing copies

documents, 59, 60
photos, 63, 65

regulatory compliance, 122
Canadian, 123
European, 123
German, 123
REACH Article 33 declarations, 124
waste labeling, European Union, 124

reminder list, printing, 45
replacing

ink cartridges, 98—100
printhead, 101—104

resolution, scanning, 68
rings to answer, 83

S
safety information, 120—121
scan mode button location and function, 2
scanner glass

cleaning, 96
location, 1

scanner lid, location, 1
scanner type, 114
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Index
scanning, 67—77
automatically detect pictures, 69
features, 114
file format

document, 68
picture, 68

from computer, 75—76
from control panel, 70
from Online Printer Management Tool, 77
loading originals, 70
multiple pictures simultaneously, 75
resolution, 68
selecting quality, 69
to computer, 71
to email, 73

setting up, 20—25
to flash drive, 72
to memory card, 72
to network folder, 74

setting up, 26—29
Service Set Identifier, 6
setting options, 49—50
settings

copy documents, 59
copy photos, 63—64
fax, 83—86
printing

photos, 49—50
sheet music, printing, 45
sleep mode, 5
software

downloading (updating), 105—106
support, 116

specifications, 113—119
physical dimensions, 116
power, 116
weight, 116

SSID, 6
start black button, location and function, 2
start color button, location and function, 2
supplies, ordering, 4
system requirements, minimum, 117—119

T
telephone service

cable, 78
digital subscriber line (DSL), 78, 79
Internet (VOIP), 78
standard, 78

tic-tac-toe, printing, 45
time and date, setting, 5
time to low power, setting, 5
transferring photos to computer, 53
transparencies, 35

tray, paper input, capacity
envelopes, 40
photo paper, 39
plain paper, 38

troubleshooting, 108—112
two-sided copying, 61
two-sided printing, 43—44

U
updating

firmware, 105—106
software, 105—106

USB connection, changing to wireless, 13
USB port

back, location, 1
front, location, 1

USB-connected device, printing from, 47

V
viewing photos, 46

W
warranty, 116, 125—126

ink, 115
Web support

contact information, 120
Electronics Industry Alliance, 95
ENERGY STAR program, 124
iPhone, iPad, and iPod Touch devices, 45
Material Safety Data Sheets (MSDS), 121
networking, 108
Pic Flick App, 45
REACH Article 33 declarations, 124
recycling, 95

wide-ruled paper, printing, 45
Wi-Fi

connectivity LED, location and function, 2
Setup wizard, 6
technology supported, 116

wireless network
configuration, viewing and printing, 11
connecting to, 6—12

additional KODAK All-in-One Printer(s), 12
from USB, 13
non-WPS router, 6
printer on additional computers, 12
using Wi-Fi Setup wizard, 6

IP Address, setting up, 10
settings, configuring, 6
subnet, viewing, 11

WPS, 6
WPS router, 8
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